
 

 
 
 
 
 
 
 
 
 

EnterpriseOne XPI 8.94 PeopleBook: 
PeopleSoft EnterpriseOne Adapter 
Programmer Guide 

D 4 
ecember 200



EnterpriseOne XPI 8.94 PeopleBook: 
PeopleSoft EnterpriseOne Adapter Programmer Guide 
 
 
Copyright© 2004 PeopleSoft, Inc. All rights reserved. 
 
All material contained in this documentation is proprietary and confidential to PeopleSoft, Inc. 
("PeopleSoft"), protected by copyright laws and subject to the nondisclosure provisions of the applicable 
PeopleSoft agreement. No part of this documentation may be reproduced, stored in a retrieval system, or 
transmitted in any form or by any means, including, but not limited to, electronic, graphic, mechanical, 
photocopying, recording, or otherwise without the prior written permission of PeopleSoft. 
 
This documentation is subject to change without notice, and PeopleSoft does not warrant that the material 
contained in this documentation is free of errors. Any errors found in this document should be reported to 
PeopleSoft in writing. 
 
The copyrighted software that accompanies this document is licensed for use only in strict accordance with 
the applicable license agreement which should be read carefully as it governs the terms of use of the software 
and this document, including the disclosure thereof. 
 
PeopleSoft, PeopleTools, PS/nVision, PeopleCode, PeopleBooks, PeopleTalk, and Vantive are registered 
trademarks, and Pure Internet Architecture, Intelligent Context Manager, and The Real-Time Enterprise are 
trademarks of PeopleSoft, Inc. All other company and product names may be trademarks of their respective 
owners. The information contained herein is subject to change without notice. 
 
Open Source Disclosure 
 
This product includes software developed by the Apache Software Foundation (http://www.apache.org/). 
Copyright (c) 1999-2000 The Apache Software Foundation. All rights reserved. THIS SOFTWARE IS 
PROVIDED “AS IS’’ AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE 
FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGE. 
 
PeopleSoft takes no responsibility for its use or distribution of any open source or shareware software or 
documentation and disclaims any and all liability or damages resulting from use of said software or 
documentation. 
 
 



 

Table of Contents 

Introduction..........................................................................................................................................................1 
Creating Packages ............................................................................................................................................3 
Creating Folders ...............................................................................................................................................3 
Creating Interface Documents.......................................................................................................................3 
Adapter Services...............................................................................................................................................4 

Business Function Template ......................................................................................................................4 
Select Template...........................................................................................................................................16 
Insert Template ..........................................................................................................................................28 
Batch Insert Template ...............................................................................................................................40 
Update Template........................................................................................................................................52 
Delete Template .........................................................................................................................................64 
XML List Query Template .......................................................................................................................74 

Notification Services .....................................................................................................................................89 
Notification Template ...............................................................................................................................89 
Disabling the Notification ........................................................................................................................97 

Flow Services ..................................................................................................................................................98 
Trigger ...........................................................................................................................................................100 

Samples..............................................................................................................................................................103 
Sample #1 – Adapter Service to call an EnterpriseOne Business Function.......................................105 

Address Book Add...................................................................................................................................105 
Running the Flow.....................................................................................................................................108 

Sample #2 – Adapter Service to call an EnterpriseOne Select database operation...........................110 
Select Database Query.............................................................................................................................110 
Running the Adapter Service..................................................................................................................111 

Sample #3 – Notification Service for Outbound Event........................................................................114 
Sales Order Notification .........................................................................................................................114 
Running the Flow.....................................................................................................................................116 

Sample #4 – Transactions ..........................................................................................................................118 
Multiple Address Book adds ..................................................................................................................118 

Sample #5 – Adapter Service for XML List Operations.......................................................................122 
AddressBook.............................................................................................................................................123 
Running the Flow.....................................................................................................................................124 

Logging..............................................................................................................................................................127 
EnterpriseOne Adapter Logs.....................................................................................................................127 
ERP8 Adapter Logs.....................................................................................................................................127 

Errors.................................................................................................................................................................128 
Error Configuring a Listener......................................................................................................................128 

PeopleSoft Proprietary and Confidential  iii 



Contents 

Error When Creating a Notification Service ...........................................................................................129 
Adapter is Not Picking Up Real-Time Events ........................................................................................129 
Adapter Runtime (Notification): Error Publishing Notification ..........................................................132 
Error Retrieving Large Records Using List Template............................................................................134 
Errors Changing the Data Selection Parameters in List Template.......................................................135 

iv  PeopleSoft Proprietary and Confidential
   



 

Introduction 

The PeopleSoft EnterpriseOne Adapter enables the exchange of information between 
PeopleSoft EnterpriseOne and other heterogeneous systems. This adapter provides a flexible, 
easy-to-use mechanism for XPI-enabled applications to interface with PeopleSoft 
EnterpriseOne.  

The EnterpriseOne Adapter exposes business logic, real-time event generation, and database 
access within EnterpriseOne.  

This guide is primarily for the developer who is responsible for creating adapter services that 
enable interoperability with PeopleSoft EnterpriseOne. The guide contains sample scenarios that 
you can view and use to assist in creating adapter services and flows.  

To view and run the sample scenarios you must:  

• Configure the PeopleSoft EnterpriseOne Adapter to connect to EnterpriseOne. When 
you install the adapter, default configurations are set up for the EnterpriseOne and 
ERP8 environments that you can edit to connect to your EnterpriseOne or ERP8 
environment.  

• Configure and enable a listener for real time events in your EnterpriseOne or ERP8 
environment. Sample listeners have been created in the 
PSFT_EnterpriseOne_AdapterSamples package. You must reconfigure the listener to 
use your EnterpriseOne or ERP8 environment.  

• Make sure that the PSFT_EnterpriseOne_AdapterSamples package, that was installed 
with the adapter, is activated. 

• Install and activate the following packages: 

1. PSFT_XrefAndSoftCoding 

2. PSFT_Utils  

Use PeopleSoft XPI Integration Developer to view and run the samples. 

Note 

The sample artifacts are built for both EnterpriseOne and ERP8 connections. Ensure that you 
are viewing and running the correct artifact for your connection.  

 

See Also 

EnterpriseOne XPI 8.94 Installation and Configuration for EnterpriseOne Adapter 
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Elements of Integration Developer 

You should be familiar with EnterpriseOne XPI products, particularly the Integration Developer. 
Integration Developer is used to create the adapter services and flows.  

The elements involved in using the Integration Developer are: 

• Creating packages 

• Creating folders 

• Creating interface documents 

• Adapter services 

• Notification services 

• Flow services 

• Trigger 

Creating Packages 

A package is a logical container for a set of services and related files. It exists as a single 
physical directory on the file system.  

► To create a package  

1. From the File menu, select New, Package, and then Next.  

2. Name your package using the integration development standards.  

See Also 

EnterpriseOne XPI 8.94 PeopleBook: Integration Development Methodology 

Creating Folders 

A folder is a logical container for a set of artifacts within a package. The top-level folder is named 
the same as the package name to avoid naming conflicts. Additional folders are provided for 
each of the artifacts (such as docs, triggers, and utils).  

► To create a folder  

1. From the File menu, select New, Folder, and then Next.  

2. Name your high-level folder the same as the package name.  

3. Create folders for the associated artifacts, using the integration development standards.  

Creating Interface Documents 

Interface documents provide the input and output to the flow services. You can create interface 
documents as part of creating a flow service, or you can create them as a separate activity. The 
following components make up the structure of an interface document:  
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• Document/Document List  –  Documents/Document Lists are collection 

• s of related fields. Any grouping within the interface document is defined as a Document 
or Document List. Examples are:  

3. Header – document  

4. Line – document list 

• Fields – Fields are the lowest level elements defined. Fields are fundamental elements 
that you use to create Documents and Document Lists (such as Description, Name, and 
so on).  

The interface document is the input and output for the web service generated from the flow. XPI 
Integration Developer requires that all fields defined in the document be of a string type. When 
defining the interface document, define the field as a string, and then update the properties to set 
the constraint to the correct XML schema data type. When the system generates the Web 
Services Description Language (WSDL), the XML references the correct data type so that the 
consumer knows which data type is required for that field in the interface.  

► To create an interface document  

1. From the File menu, select New, and then Document Type.  

2. Click Next.  

3. Name your Interface Document and place it in the Docs folder for your package.  

4. Select a source.  

5. Create a document structure.  

Adapter Services  

An Adapter Service is created from an operation template to perform a specific operation on a 
resource. For example, the EnterpriseOne adapter provides a template for performing business 
functions calls. This is how the adapter transfers data and communicates with the EnterpriseOne 
resource.  

Business Function Template  

The Business Function Template has built-in hooks for calling EnterpriseOne business functions. 
You can use one template for several operations, so the adapter may have many adapter 
services. Each adapter service is a one-to-one mapping to a business function.  

► To create an Adapter Service  

1. From the File menu, select New, and then Adapter Service. 

2. Click Next.  
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3. Select EnterpriseOne Adapter, and then click Next.  

  

4. On New Adapter Service, select either EnterpriseOne or ERP8, and then click Next.  
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5. Select a business function template, and then click Next.  

6. Name your Adapter Service following the naming standards in the EnterpriseOne XPI 
8.94 PeopleBook: Integration Development Methodology. 

7. Place the Adapter Service in an Adapter Services package, and then click Finish. 

8. Select the newly created Adapter Service.  

The following information appears in the right pane under the Business Function tab:  

EnterpriseOne Connection Description 
Library Name The name of the DLL in EnterpriseOne to which the business function 

belongs. 

Interface Name The name of the C module or NER in EnterpriseOne. 

Business Function Name The name of the business function in EnterpriseOne. 

Typed or String input fields Defines the type of the input document fields. If specified to Typed, the 
input document will contain typed fields, such as Double, Character, 
Date, which match the BSFN data structure fields. If specified as String, 
the input document fields will be String type, which will then be 
converted internally to the BSFN data structure field types. 

Note: Below the information about the business function, you will find the input data structure parameters 
and the output data structure parameters. 

Typed or String output fields Defines the type of the output document fields. If specified to Typed, the 
output document will contain typed fields, such as Double, Character, 
Date, which match the BSFN data structure fields. If specified as String, 
the output document fields will be String type, which after a BSFN call 
the adapter will convert all the BSFN output fields to a String. 
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9. Click the drop-down menu in each of the following fields and select the appropriate 
values for each: 

5. Library Name 

6. Interface name 

7. Business Function Name 

8. Typed or String Input Fields 

10. Under the BSFN Input Field Names area, select one value at a time or select all. 

11. Click the Typed or String Output Fields drop-down menu and select one value at a time 
or select all.  

12. Your finished adapter service should look like the following example:  
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13. Save the Adapter Service.  

ERP8 Connection Description 
Library Name The Java wrapper jar name to which the business 

function belongs 

Interface Name The grouping name within the Java wrapper 

Business Function Name The name of the business function in ERP8 

Typed or String input fields Defines the type of the input document fields. If 
specified as Typed, the input document will contain 
typed fields, such as Double, Character, and Date, 
which match the BSFN data structure fields. If 
specified as String, the input document fields will all 
be of String type, which will then be converted 
internally to the BSFN data structure field types. 

Note: Below the information about the business function, you will find the input data structure parameters and 
the output data structure parameters. 
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Typed or String output fields Defines the type of the output document fields. If 
specified as Typed, the output document will contain 
typed fields, such as Double, Character, Date, which 
match the BSFN data structure fields. If specified as 
String, the output document fields will all be of String 
type, which after a BSFN call, the adapter will convert 
all the BSFN output fields to a String. 

 

14. Click the drop-down menu in each of the following fields and select the appropriate 
values for each: 

9. Library Name 

10. Interface name 

11. Business Function Name 

12. Typed or String Input Fields 

15. Under the BSFN Input Field Names area, select one value at a time or select all. 

16. Click the Typed or String Output Fields drop-down menu and select one value at a time, 
or select all.  

Your finished adapter service should look like this:  

 

17. Save the Adapter Service.  
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18. Review the information that appears on the following tabs:  

Adapter Settings Tab 

• Adapter Name 

The name of the adapter. 

• Adapter Connection Name 

The name of the connection specified when the adapter service was created. 

• Adapter Service Template 

The name for the adapter template used to create the adapter service. 
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Input/Output Tab 

• Input  

The input interface document for the adapter service. This is the list of input parameters 
selected from the business function parameters. 

Part of the input is a Control structure that contains three parameters,TruncateStrings, 
dateFormat, and stripTrailingBlanks. When TruncateStrings is set to True, this 
parameter tells the adapter to either truncate string values to the length specified in the 
data dictionary. When set to False the adapter will not truncate strings, which could 
result in an exception if a string value is to long for the field. The default value is True.  

Note 
This parameter only exists on EnterpriseOne Business Function services. 

 
The dateFormat parameter tells the adapter how to format String values into dates. The 
format applies to both input and output date values. The default format for dates is: 
MM/dd/yyyy. Where MM = months, dd = days, yyyy = years. 

Note 
The case of this format is important. MM/dd/yyyy does not equal mm/dd/yyy and does 
not equal MM/DD/YYYY. 

 
 The stripTrailingBlanks parameter tells the adapter to strip any trailing blanks from 

returned values. By default this value is False. Values which contain only blanks 
(spaces), will not be modified. 

• Output  

The output interface document for the adapter service. This is the list of output 
parameters selected from the business function parameters. 

In addition to the output parameters, there is a HasWarnings boolean field and a 
WarningMsgs string array field. If the executed business function returns a warning (a 
return code of 1), the HasWarnings field will be set to True. When set to True, the 
WarningsMsgs field contains all the warning messages returned by the business 
function. If the business function returns successfully (a return code of 0), the 
HasWarnings field is set to false and the WarningMsgs field is null. 

If the business function returns an error (a return code of 2) the adapter throws an 
exception into the Flow. This exception should be caught with a Try/Catch block. It is 
possible for a BSFN to return error messages but report back a return code of success 
(0). In these cases the adapter will treat the BSFN as an error and throw an exception 
into the Flow. 
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Settings Tab 

On the Settings tab, the system defines the template file associated with the selected service, 
assigns run-time parameters, and assigns a universal name. This is currently not used by the 
EnterpriseOne adapter.  
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Audit Tab  

• Enable Service Auditing 

The Enable Service Auditing section defines how you want to audit. Values include: 
Never, For top-level service only, Always. 

• When to log 

This section defines when to log. Values include: Errors only, Error and Success, Error, 
Success and Start. 

• When to include input pipeline  

This section defines when to include the pipeline in the log. Values include: Never, On 
errors only, Always. 
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Permissions Tab  

• List ACL 

Users in the allowed list can see that the elements exist and view the elements 
metadata (input, output, and so on).  

• Read ACL 

Users in the allowed list can view the source code and metadata for the element.  

• Write ACL 

Users in the allowed list can lock, edit, rename, and delete the element.  

• Execute ACL 

Users in the allowed list can run the service.  

• Enforce Execute ACL  

This field’s values include: For top-level Service only, Always. 

• ACL Information 

Click to view the users and groups that compose the ACLs on the Integration Server to 
which you are connected. This information is read only. To edit ACLs, users, and 
groups, use the Integration Server Administrator. 
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Results Tab 

When testing and debugging in the XPI Integration Developer tool, the results of the 
service appear in this tab.  

 

 

Select Template  

The Select Template enables you to execute a Select database operation against any table or 
business view in the EnterpriseOne database. The system performs all scrubbing operations 
(such as decimal shifting, date conversion, and so on) before the data is returned to you. Each 
adapter service is a one-to-one mapping to a configured select query.  

► To create an Adapter Service  

1. From the File menu, select New, and then Adapter Service. 

2. Click Next.  
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3. Select EnterpriseOne Adapter, and then click Next.  

  

4. On New Adapter Service, select EnterpriseOne, and then click Next.  
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5. Select the Select template, and then click Next.  

6. Name your Adapter Service following the naming standards in the EnterpriseOne XPI 
8.94 PeopleBook: Integration Development Methodology. 

7. Place the Adapter Service in an Adapter Services package, and then click Finish. 

8. Select the newly created Adapter Service.  

The following information appears in the right pane under the Select tab:  

EnterpriseOne Connection Description 
Type Determines whether the query will run against a table or a business 

view 

Name The name of the table or business view. 

Description A non-editable field that contains the description of the selected table or 
business view. 

All or Distinct Allows you to choose whether the query will return All rows or whether it 
will return only Distinct rows. 

Note: The table or business view column information appears below the All or Distinct drop-down box. 

Max Rows The maximum number of rows to return in the query. A less than (<) or 
equal (=) to zero (0) will return all rows.  
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9. Click the drop-down menu in each of the following fields and select the appropriate 
values for each: 

13. Type 

14. Name 

15. All or Distinct 

10. Under the Column information area, select one value at a time or select all.  

Note 
For performance reasons, you should only select the columns for which you need data 
returned. 

 

For any row that has a Field Type other than String, you may select the Field Type box 
and select the default data type (such as Double, Date, and so on) and change it to a 
String. This changes the data type of the output field for this row. 

11. Your finished adapter service should look like this example:  
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12. Save the Adapter Service.  

13. Click the WHERE tab. 
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This tab allows you to create a Where clause that filters the data in a query. 

14. Select the Insert Row to add a Where clause line. 

a. Select AND/OR to determine how this line is applied to the line above it. The 
AND/OR value for the first line does not matter. 

b. Under the Left Grouping column, select the grouping level for the line. By placing 
multiple Where clause lines at the same grouping level, you can build up complex 
Where clauses.  

c. Select the column to apply the Where clause filter to. 

d. Select the operator. 

e. Select the input field for the filter value. You can rename this field. 

f. Repeat these steps for as many Where clause lines are needed.  

15. Review the information that appears on the following tabs:  
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Adapter Settings Tab 

• Adapter Name 

The name of the adapter. 

• Adapter Connection Name 

The name of the connection specified when the adapter service was created. 

• Adapter Service Template 

The name for the adapter template used to create the adapter service. 
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Input/Output Tab 

• Input  

The input interface document for the adapter service. This will be the set of parameters 
required for the created Where clause. 

Part of the input is a Control structure that contains three parameters, dateFormat, 
stripTrailingBlanks, and overrideMaxRows. The dateFormat parameter tells the adapter 
how to format String values into dates. The default format for dates is: MM/dd/yyyy. 
Where MM = months, dd = days, yyyy = years. 

Note 
The case of this format is important. MM/dd/yyyy does not equal mm/dd/yyy and does 
not equal MM/DD/YYYY. 

 
 The stripTrailingBlanks parameter tells the adapter to strip trailing blanks from values 

returned in the result set. The default value for this parameter is False. Returned values 
that contain only blanks (spaces) will not be modified. 

 The overrideMaxRows parameter allows you to pass in an integer value to override the 
maximum number of rows that the adapter returns at runtime. If the adapter template is 
set at design time to return 10 rows, at runtime this value can be changed to 100, 
depending on the needs of the Flow. If this value is left blank or contains an invalid 
value, the default value that is set at design time will be used. 

• Output  

The output interface document for the adapter service. This contains a resultSet array 
that has fields for every column selected. 

If an error occurs while executing the Select query, the adapter throws an exception into 
the Flow. This exception should be caught with a Try/Catch block. 
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Settings Tab 

On the Settings tab, the system defines the template file associated with the selected 
service, assigns run-time parameters, and assigns a universal name. This is currently 
not used by the EnterpriseOne adapter.  
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Audit Tab  

• Enable Service Auditing 

The Enable Service Auditing section defines how you want to audit. Values include: 
Never, For top-level service only, Always. 

• When to log 

This section defines when to log. Values include: Errors only, Error and Success, Error, 
Success and Start. 

• When to include input pipeline  

This section defines when to include the pipeline in the log. Values include: Never, On 
errors only, Always. 
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Permissions Tab  

• List ACL 

Users in the allowed list can see that the elements exist and view the elements 
metadata (input, output, and so on).  

• Read ACL 

Users in the allowed list can view the source code and metadata for the element.  

• Write ACL 

Users in the allowed list can lock, edit, rename, and delete the element.  

• Execute ACL 

Users in the allowed list can run the service.  

• Enforce Execute ACL  

This field’s values include: For top-level service only, Always. 

• ACL Information 

Click to view the users and groups that compose the ACLs on the Integration Server to 
which you are connected. This information is read only. To edit ACLs, users, and 
groups, use the Integration Server Administrator. 
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Results Tab 

When testing and debugging in the XPI Integration Developer tool, the results of the 
service appear in this tab.  

 

 

Insert Template  

The Insert Template allows a user to execute an Insert database operation against select tables 
or business views in the EnterpriseOne database. Insert operations are limited to specified 
interface tables (Z tables) and F47 tables. The system performs all scrubbing operations (such 
as decimal shifting, date conversion, and so on) before the data is returned to you. Each adapter 
service is a one-to-one mapping to a configured insert operation.  

► To create an Adapter Service  

1. From the File menu, select New, and then Adapter Service. 

2. Click Next.  
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3. Select EnterpriseOne Adapter, and then click Next.  

  

4. On New Adapter Service, select EnterpriseOne, and then click Next.  
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5. Select the Insert template, and then click Next.  

6. Name your Adapter Service following the naming standards in the EnterpriseOne XPI 
8.94 PeopleBook: Integration Development Methodology. 

7. Place the Adapter Service in an Adapter Services package, and then click Finish. 

8. Select the newly created Adapter Service.  

The following information appears in the right pane under the Insert tab:  

EnterpriseOne Connection Description 
Type Whether the Insert operation will run against a table or a business view 

Name The name of the table or business view. 

Description A non-editable field that contains the description of the selected table of 
business view. 

Note: The table or business view column information appears below the Description field. 
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9. Click the drop-down menu in each of the following fields and select the appropriate 
values for each: 

16. Type 

17. Name 

10. Under the Column information area, select one value at a time or select all. 

For any row that has a Field Type other then String, you may select the Field Type box 
and select either the default data type (such as Double, Date, and so on) and change it 
to a String. This changes the data type of the input field for this row. 
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Your finished adapter service should look like the following example:  

 

11. Save the Adapter Service.  

12. Review the information that appears on the following tabs:  
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Adapter Settings Tab 

• Adapter Name 

The name of the adapter. 

• Adapter Connection Name 

The name of the connection specified when the adapter service was created. 

• Adapter Service Template 

The name for the adapter template used to create the adapter service. 
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Input/Output Tab 

• Input  

The input interface document for the adapter service. This document contains fields for 
all the selected columns. Each input document field will be titled the same as the 
selected column. 

Part of the input is a Control structure that contains one parameter - dateFormat. This 
parameter tells the adapter how to format String values into dates. The default format for 
dates is: MM/dd/yyyy. Where MM = months, dd = days, yyyy = years. 

Note 
The case of this format is important. MM/dd/yyyy does not equal mm/dd/yyy and does 
not equal MM/DD/YYYY. 

 
• Output  

The output interface document for the adapter service. The output document contains a 
single field titled numRowsInserted, which returns the number of rows inserted. For the 
Insert template, this value is always one (1) when the insert operation completes 
successfully. 

If an error occurs while executing the Insert operation, the adapter throws an exception 
into the Flow. This exception should be caught with a Try/Catch block. 
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Settings Tab 

On the Settings tab, the system defines the template file associated with the selected 
service, assigns run-time parameters, and assigns a universal name. This is currently 
not used by the EnterpriseOne adapter.  
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Audit Tab  

• Enable Service Auditing 

The Enable Service Auditing section defines how you want to audit. Values include: 
Never, For top-level service only, Always. 

• When to log 

This section defines when to log. Values include: Errors only, Error and Success, Error, 
Success and Start. 

• When to include input pipeline  

This section defines when to include the pipeline in the log. Values include: Never, On 
errors only, Always. 
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Permissions Tab  

• List ACL 

Users in the allowed list can see that the elements exist and view the metadata (input, 
output, and so on) for the elements.  

• Read ACL 

Users in the allowed list can view the source code and metadata for the element.  

• Write ACL 

Users in the allowed list can lock, edit, rename, and delete the element.  

• Execute ACL 

Users in the allowed list can run the service.  

• Enforce Execute ACL  

This field’s values include: For top-level Service only, Always. 

• ACL Information 

Click to view the users and groups that compose the ACLs on the Integration Server to 
which you are connected. This information is read only. To edit ACLs, users, and 
groups, use the Integration Server Administrator. 
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Results Tab 

When testing and debugging in the XPI Integration Developer tool, the results of the 
service appear in this tab.  

 

 

Batch Insert Template  

The Batch Insert Template allows a user to execute a Batch Insert database operation against 
select tables or business views in the EnterpriseOne database. Batch Insert operations are 
limited to specified interface tables (Z tables) and F47 tables. The system performs all scrubbing 
operations (such as decimal shifting, date conversion, and so on) before the data is returned to 
you. Each adapter service is a one-to-one mapping to a configured batch insert operation.  

► To create an Adapter Service  

1. From the File menu, select New, and then Adapter Service. 

2. Click Next.  
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3. Select EnterpriseOne Adapter, and then click Next.  

  

4. On New Adapter Service, select EnterpriseOne, and then click Next.  
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5. Select the Batch Insert template, and then click Next.  

6. Name your Adapter Service following the naming standards in the EnterpriseOne XPI 
8.94 PeopleBook: Integration Development Methodology. 

7. Place the Adapter Service in an Adapter Services package, and then click Finish. 

8. Select the newly created Adapter Service.  

The following information appears in the right pane under the Batch Insert tab:  

EnterpriseOne Connection Description 
Type Whether the Batch Insert operation runs against a table or a business 

view 

Name The name of the table or business view. 

Description A non-editable field that contains the description of the selected table or 
business view. 

Note: The table or business view column information appears below the Description field. 
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9. Click the drop-down menu in each of the following fields and select the appropriate 
values for each: 

18. Type 

19. Name 

10. Under the Column information area, select one value at a time or select all. 

For any row that has a Field Type other then String, you may select the Field Type box 
and select either the default data type (such as Double, Date, and so on) and change it 
to a String. This changes the data type of the input field for this row. 
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Your finished adapter service should look like the following example:  

 

11. Save the Adapter Service.  

12. Review the information that appears on the following tabs:  
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Adapter Settings Tab 

• Adapter Name 

The name of the adapter. 

• Adapter Connection Name 

The name of the connection specified when the adapter service was created. 

• Adapter Service Template 

The name for the adapter template used to create the adapter service. 
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Input/Output Tab 

• Input  

The input interface document for the adapter service. This document contains fields for 
all of the selected columns. Each input document field is titled the same as the selected 
column. 

Part of the input is a Control structure that contains one parameter, dateFormat. This 
parameter tells the adapter how to format String values into dates. The default format for 
dates is: MM/dd/yyyy. Where MM = months, dd = days, yyyy = years. 

Note 
The case of this format is important. MM/dd/yyyy does not equal mm/dd/yyy and does 
not equal MM/DD/YYYY. 

 
• Output  

The output interface document for the adapter service. The output document contains a 
single field, numRowsInserted, that returns the number of rows inserted. 

If an error occurs while executing the Insert operation, the adapter throws an exception 
into the Flow. This exception should be caught with a Try/Catch block. 
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Settings Tab 

On the Settings tab, the system defines the template file associated with the selected 
service, assigns run time parameters, and assigns a universal name. This is currently 
not used by the EnterpriseOne adapter.  

 

48  PeopleSoft Proprietary and Confidential
   



  EnterpriseOne Adapter Programmer Guide 

Audit Tab  

• Enable Service Auditing 

The Enable Service Auditing section defines how you want to audit. Values include: 
Never, For top-level service only, Always. 

• When to log 

This section defines when to log. Values include: Errors only, Error and Success, Error, 
Success and Start. 

• When to include input pipeline  

This section defines when to include the pipeline in the log. Values include: Never, On 
errors only, Always. 
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Permissions Tab  

• List ACL 

Users in the allowed list can see that the elements exist and view the metadata (input, 
output, and so on) for the elements.  

• Read ACL 

Users in the allowed list can view the source code and metadata for the element.  

• Write ACL 

Users in the allowed list can lock, edit, rename, and delete the element.  

• Execute ACL 

Users in the allowed list can run the service.  

• Enforce Execute ACL  

This field’s values include: For top-level Service only, Always. 

• ACL Information 

Click to view the users and groups that compose the ACLs on the Integration Server to 
which you are connected. This information is read only. To edit ACLs, users, and 
groups, use the Integration Server Administrator. 
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Results Tab 

When testing and debugging in the XPI Integration Developer tool, the results of the 
service appear in this tab.  

 

 

Update Template  

The Update Template enables a user to execute an Update database operation against select 
tables or business views in the EnterpriseOne database. Update operations are limited to 
specified interface tables (Z tables) and F47 tables. The system performs all scrubbing 
operations (such as decimal shifting, date conversion, and so on) before the data is returned to 
the user. Each adapter service is a one-to-one mapping to a configured update operation.  

► To create an Adapter Service  

1. From the File menu, select New, and then Adapter Service. 

2. Click Next.  
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3. Select EnterpriseOne Adapter, and then click Next.  

  

4. On New Adapter Service, select EnterpriseOne, and then click Next.  
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5. Select the Update template, and then click Next.  

6. Name your Adapter Service following the naming standards in the EnterpriseOne XPI 
8.94 PeopleBook: Integration Development Methodology. 

7. Place the Adapter Service in an Adapter Services package, and then click Finish. 

8. Select the newly created Adapter Service.  

The following information appears in the right pane under the Update tab:  

EnterpriseOne Connection Description 
Type Determines whether the update operation will run against a table or a 

business view. 

Name The name of the table or business view. 

Description A non-editable field that contains the description of the selected table or 
business view. 

Note: The table or business view column information appears below the Description field. 
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9. Click the drop-down menu in each of the following fields and select the appropriate 
values for each: 

20. Type 

21. Name 

10. Under the Column information area, select one value at a time or select all. 

For any row that has a field type other than String, you can select the Field Type box 
and select the default data type (such as Double, Date, and so on) and change it to a 
String. This changes the data type of the output field for this row. 
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Your finished adapter service should look like the following example:  

 

11. Save the Adapter Service.  

12. Click the WHERE tab. 
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13. This tab enables you to create a Where clause that filters the data in a query. 

14. Select the Insert Row to add a Where clause line. 

a. Select AND/OR to determine how this line is applied to the line above it. The 
AND/OR value for the first line does not matter. 

b. Under the Left Grouping column, select the grouping level for the line. By placing 
multiple Where clause lines at the same grouping level, you can build up complex 
Where clauses.  

c. Select the column to apply the Where clause filter to. 

d. Select the operator. 

e. Select the input field for the filter value. You can rename this field.  

Note  
Do not set this name to the column name. The column name is used as the input 
field name for the update operation. PeopleSoft recommends to always start a 
Where clause name with “INPUT_”. 

 

f. Repeat these steps for as many Where clause lines that are needed.  

15. Save the Adapter Service. 

16. Review the information that appears on the following tabs:  
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Adapter Settings Tab 

• Adapter Name 

The name of the adapter. 

• Adapter Connection Name 

The name of the connection specified when the adapter service was created. 

• Adapter Service Template 

The name for the adapter template used to create the adapter service. 
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Input/Output Tab 

• Input  

The input interface document for the adapter service. This document contains the set of 
columns selected for the update operation and the set of parameters required for the 
Where clause. 

Part of the input is a control structure that contains two parameters, acceptNullValues 
and dateFormat. The acceptNullValues parameter tells the adapter how to handle null 
input parameters. If this value is set to TRUE, null values are accepted and null is 
inserted into the updated field in the database. If this value is set to FALSE, fields that 
have been given a null value are removed from the update operation; and the field’s 
existing value remains after the update succeeds. The default value for this field is 
TRUE. 

The dateFormat parameter tells the adapter how to format String values into dates. The 
default format for dates is: MM/dd/yyyy. Where MM = months, dd = days, yyyy = years. 

Note  
The case of this format is important. MM/dd/yyyy does not equal mm/dd/yyy and does 
not equal MM/DD/YYYY. 

 
• Output  

The output interface document for the adapter service. This contains a single field, 
numRowsUpdated. The value in this field is the number of rows updated with the 
operation. 

If an error occurs while executing the Select query, the adapter throws an exception into 
the flow. This exception should be caught with a Try/Catch block. 
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Settings Tab 

On the Settings tab, the system defines the template file associated with the selected 
service, assigns run-time parameters, and assigns a universal name. This is currently 
not used by the EnterpriseOne adapter.  
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Audit Tab  

• Enable Service Auditing 

The Enable Service Auditing section defines how you want to audit. Values include: 
Never, For top-level service only, Always. 

• When to log 

This section defines when to log. Values include: Errors only, Error and Success, Error, 
Success and Start. 

• When to include input pipeline  

This section defines when to include the pipeline in the log. Values include: Never, On 
errors only, Always. 
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Permissions Tab  

• List ACL 

Users in the allowed list can see that the elements exist and view the metadata (input, 
output, and so on) for the elements.  

• Read ACL 

Users in the allowed list can view the source code and metadata for the element.  

• Write ACL 

Users in the allowed list can lock, edit, rename, and delete the element.  

• Execute ACL 

Users in the allowed list can run the service.  

• Enforce Execute ACL  

The values for this field include: For top-level service only, Always. 

• ACL Information 

Click to view the users and groups that compose the ACLs on the Integration Server to 
which you are connected. This information is read only. To edit ACLs, users, and 
groups, use the Integration Server Administrator. 
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Results Tab 

When testing and debugging in the XPI Integration Developer tool, the results of the 
service appear in the Results tab.  

 

 

Delete Template  

The Delete Template enables you to execute a delete database operation against select tables 
or business views in the EnterpriseOne database. Delete operations are limited to specified 
interface tables (Z tables) and F47 tables. The system performs all scrubbing operations (such 
as decimal shifting, date conversion, and so on) before the data is returned. Each adapter 
service is a one-to-one mapping to a configured delete operation.  

► To create an Adapter Service  

1. From the File menu, select New, and then Adapter Service. 

2. Click Next.  
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3. Select EnterpriseOne Adapter, and then click Next.  

  

4. On New Adapter Service, select EnterpriseOne, and then click Next.  
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5. Select the Delete template, and then click Next.  

6. Name your Adapter Service following the naming standards in the EnterpriseOne XPI 
8.94 PeopleBook: Integration Development Methodology. 

7. Place the Adapter Service in an Adapter Services package, and then click Finish. 

8. Select the newly created Adapter Service.  

The following information appears in the right pane under the Delete tab:  

EnterpriseOne Connection Descriptions 
Type Whether the delete operation will run against a table or a business view. 

Name The name of the table or business view. 

Description A non-editable field that contains the description of the selected table or 
business view. 

Note: Below the Description field you will find information to create a Where clause to control which 
database rows are deleted. 
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9. Click the drop-down menu in each of the following fields and select the appropriate 
values for each: 

22. Type 

23. Name 

10. Under the Where information area, select the Insert Row to add a Where clause line. 

a. Select AND/OR to determine how this line is applied to the line above it. The 
AND/OR value for the first line does not matter. 

b. Under the Left Grouping column, select the grouping level for the line. By placing 
multiple Where clause lines at the same grouping level, you can build up complex 
Where clauses.  

c. Select the column to apply the Where clause filter to. 

d. Select the operator. 

e. Select the input field for the filter value. You can rename this field to whatever is 
needed. 

f. Repeat these steps for as many Where clause lines are needed.  

11. Save the Adapter Service. 

12. Your finished adapter service should look like the following example:  
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13. Review the information that appears on the following tabs:  
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Adapter Settings Tab 

• Adapter Name 

The name of the adapter. 

• Adapter Connection Name 

The name of the connection specified when the adapter service was created. 

• Adapter Service Template 

The name for the adapter template used to create the adapter service. 
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Input/Output Tab 

• Input  

The input interface document for the adapter service. This document contains the set of 
parameters required for the Where clause. 

Part of the input is a control structure that contains one parameter, dateFormat. The 
dateFormat parameter tells the adapter how to format String values into dates. The 
default format for dates is: MM/dd/yyyy. Where MM = months, dd = days, yyyy = years. 

Note 
The case of this format is important. MM/dd/yyyy does not equal mm/dd/yyy and does 
not equal MM/DD/YYYY. 

 
• Output  

The output interface document for the adapter service. This contains a single field, 
numRowsDeleted. This field contains the number of rows deleted from the operation. 

If an error occurs while executing the delete operation, the adapter throws an exception 
into the flow. This exception should be caught with a Try/Catch block. 
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Settings Tab 

On the Settings tab, the system defines the template file associated with the selected 
service, assigns run-time parameters, and assigns a universal name. This is currently 
not used by the EnterpriseOne adapter.  
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Audit Tab  

• Enable Service Auditing 

The Enable Service Auditing section defines how you want to audit. Values include: 
Never, For top-level service only, Always. 

• When to log 

This section defines when to log. Values include: Errors only, Error and Success, Error, 
Success and Start. 

• When to include input pipeline  

This section defines when to include the pipeline in the log. Values include: Never, On 
errors only, Always. 
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Permissions Tab  

• List ACL 

Users in the allowed list can see that the elements exist and view the metadata (input, 
output, and so on) for the elements.  

• Read ACL 

Users in the allowed list can view the source code and metadata for the element.  

• Write ACL 

Users in the allowed list can lock, edit, rename, and delete the element.  

• Execute ACL 

Users in the allowed list can run the service.  

• Enforce Execute ACL  

This values for this field include: For top-level service only, Always. 

• ACL Information 

Click to view the users and groups that compose the ACLs on the Integration Server to 
which you are connected. This information is read only; to edit ACLs, users, and groups, 
use the Integration Server Administrator. 
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Results Tab 

When testing and debugging in the XPI Integration Developer tool, the results of the 
service appear in the Results tab.  

 

 

XML List Query Template  

The XML List Query Template has built-in hooks for calling EnterpriseOne list operations. You 
can use one template for several operations; therefore, the adapter can have many adapter 
services. Each adapter service is a one-to-one mapping to a table, view, or table conversion.  

► To create an Adapter Service  

1. From the File menu, select New, and then Adapter Service. 

2. Click Next.  
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3. Select EnterpriseOne Adapter, and then click Next.  

  

4. On New Adapter Service, select ERP8, and then click Next.  

Note 
The XML List template is available for ERP8 connections only. 
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5. Select a XML List Query template, and then click Next.  

6. Name your Adapter Service following the naming standards in the EnterpriseOne XPI 
8.94 PeopleBook: Integration Development Methodology. 

7. Place the Adapter Service in an Adapter Services package, and then click Finish. 

8. Select the Adapter Service.  

The following information appears in the left pane:  

Item Description 
ERP8 Connection  

List Data Source Type The type of the EnterpriseOne list data source. This could be a table, 
view, table conversion, or foreign table. 

TC Version The version of the table conversion data source selected. 

List Data Source Name The name of the table, view, or table conversion.  

Note: The Data Sequencing tab provides the capability to prepare the data sequence. In addition, it 
provides the capability to do data selection on the selected list data source. The Retrieve Record tab 
enables you to select the columns for the template output. 
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9. Click the List Data Source Type drop-down menu and select the appropriate values. 

10. Type in the source name in the List Data Source Name field. 

11. Under the Data Sequencing, select one value at a time or select all. 

12. Under Data Selection, select one value at a time or select all. Select the required clause, 
column, and operator to prepare the data selection statement. 

Note 
The first row clause should always be WHERE. 

 

13. Your finished adapter service should look like the following example:  
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Data Sequencing Tab 

 

Data Selection Tab 
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You can hard code the data selection value using the Operand column, as shown below. 

 

Note 
The values should be separated by a comma (,) for the set operators, such as BW, IN, 
and so on. The date values should always be in the List Data format (yyyyMMdd), with 
no separator characters such as ‘a forward slash (/) or a dash (-). 

 

Retrieve Record Tab 

 

14. Save the Adapter Service.  

15. Review the information that appears on the following tabs:  
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Adapter Settings Tab 

 

• Adapter Name 

The name of the adapter. 

• Adapter Connection Name 

The name of the connection specified when the adapter service was created. 

• Adapter Service Template 

The name for the adapter template used to create the adapter service. 
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Input/Output Tab 

 

• Input  

The input interface document for the adapter service. This is the list of input parameters 
in the control section and columns selected list data source in the data selection 
statements. 

• Output  

The output interface document for the adapter service. This is the list of standard output 
parameters and parameters selected from the data source columns.  

The template runs in six different modes depending upon the input values. Refer to the 
following table to determine the input parameters for the desired operation:  

Operations Input Parameters Output Parameters 

listHandle Null or empty string 

listSize Null or empty string 

ListHandle The handle 
returned by the 
create list operation 

lastProcessedIndex Null or empty string 

startIndex Null or empty string 

ListSize The size of the list 
created by create 
list operation 

endIndex Null or empty string 

Create List 

deleteList False 

LastProcessedIndex Null or empty string 
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Operations Input Parameters Output Parameters 

listHandle Valid list handle The listHandle 
passed in as input 
parameter 

listSize Valid list size 

ListHandle 

 

lastProcessedIndex Null, empty String, 
or a valid index. 
When this field is 
set, the Retrieve list 
retrieves the records 
next to this index 
and up to the 
endIndex 

startIndex When the 
lastProcessedIndex 
is not set to a valid 
index, this field 
should be set to a 
valid index (1 to 
listSize). 

ListSize The listSize passed 
in as input 
parameter 

endIndex If null or empty 
string is the value for 
this field, then the 
list from either the 
lastProcessedIndex 
or startIndex up to 
the last index is 
retrieved. 

Retrieve list 

deleteList False 

LastProcessedIndex Index of the last 
record processed 
by the retrieve list 
operation. 

listHandle Valid list handle 

listSize Null, empty string, 
or valid list size 

ListHandle Null or empty String 

lastProcessedIndex Null, empty String 

startIndex Null  empty String 

ListSize Null or Empty 
String 

endIndex Null, empty String 

Delete list 

deleteList True 

 

LastProcessedIndex Null or Empty 
String 

listHandle Null or empty 
string 

Create and 
Retrieve list 

listSize Null or empty string 

ListHandle The handle 
returned by the 
create list 
operation 
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Operations Input Parameters Output Parameters 

lastProcessedIndex Null or empty string 

startIndex 1 

ListSize The size of the list 
created by the 
create list operation 

endIndex Any value more 
than 1. If a null or 
empty String is 
passed, the 
endIndex is 
assumed to be the 
last Index. If the 
endIndex is greater 
than the listsize, 
then the endIndex is 
set to listSize 

deleteList False 

LastProcessedIndex The last element 
index retrieved 
based on the 
endIndex 

listHandle Valid list handle 

listSize Valid list size 

ListHandle Null or empty string 

lastProcessedIndex Null, empty String or 
a valid index. When 
this field is set, the 
Retrieve list 
retrieves the 
records next to this 
index and up to the 
endIndex. 

startIndex When the 
lastProcessedIndex 
is not set to a valid 
index, this field 
should be set to a 
valid index (1 to 
listSize). 

ListSize Null or empty string 

endIndex If null or empty 
string is the value 
for this field, then 
the list from either 
the 
lastProcessedIndex 
or startIndex up to 
the last index is 
retrieved. 

Retrieve and 
Delete list 

deleteList  True 

LastProcessedIndex -1 

Create, 
Retrieve and

listHandle Null or empty string ListHandle Null or Empty String 
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Operations Input Parameters Output Parameters 

listSize Null or empty string 

lastProcessedIndex Null or empty string 

startIndex 1 

ListSize Null or Empty String 

endIndex Any value more 
than 1. If a null or 
empty String is 
passed, the 
endIndex is 
assumed to be the 
last Index. If the 
endIndex is greater 
than the listsize, 
then the endIndex is 
set to listSize 

Retrieve and 
Delete list 

deleteList True 

LastProcessedIndex -1 
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Settings Tab 

On the Settings tab, the system defines the template file associated with the selected 
service, assigns run-time parameters, and assigns a universal name. This is currently 
not used by the EnterpriseOne adapter.  
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Audit Tab  

 

• Enable Service Auditing 

The Enable Service Auditing section defines how you want to audit. Values include: 
Never, For top-level service only, Always. 

• When to log 

This section defines when to log. Values include: Errors only, Error and Success, Error, 
Success and Start. 

• When to include input pipeline  

This section defines when to include the pipeline in the log. Values include: Never, On 
errors only, Always. 
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Permissions Tab  

 

• List ACL 

Users in the allowed list can see that the elements exist and view the elements 
metadata (input, output, and so on).  

• Read ACL 

Users in the allowed list can view the source code and metadata for the element.  

• Write ACL 

Users in the allowed list can lock, edit, rename, and delete the element.  

• Execute ACL 

Users in the allowed list can run the service.  

• Enforce Execute ACL  

The values for this field include: For top-level service only, Always. 

• ACL Information 

Click to view the users and groups that compose the ACLs on the Integration Server to 
which you are connected. This information is read only; to edit ACLs, users, and groups, 
use the Integration Server Administrator. 
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Results Tab 

When testing and debugging in the XPI Integration Developer tool, the results of the 
service appear in this tab.  
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Notification Services  

A Notification Service is created from an operation template to trigger a notification flow for a 
real-time event from EnterpriseOne. This is how the adapter transfers data and communicates 
with the EnterpriseOne resource.  

Notification Template  

The Outbound Template exposes the real-time events, Z events, and workflow events from 
EnterpriseOne. It has built-in hooks for receiving events from EnterpriseOne. You can use one 
template for several operations; therefore, the adapter may have many notification services. 
Each notification service is a one-to-one mapping to an event.  

► To create a notification service  

1. Create a listener for the notification.  

Note 
For more information, see the PeopleSoft EnterpriseOne XPI 8.94 Installation and 
Configuration for EnterpriseOne Adapter.  

 

2. From the File menu, select New, and then Adapter Notification. 

3. Click Next.  

 

4. On New Adapter Notification, select EnterpriseOne Adapter as the adapter type.  
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5. Select the ERP Event Notification template, and then click Next.  

 

6. Select the Listeners:NotificationEnterpriseOne line, and then click Next. 

7. Name your Adapter Notification Service following the naming standards in the 
EnterpriseOne XPI 8.94 PeopleBook: Integration Development Methodology. 

8. Place the Adapter Notification Service in an Adapter Services package, and then click 
Next. 

9. Click Finish to create the Notification Adapter service and document.  

The system creates an Adapter Notification Service and an associated document.  
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10. Select the Notification Service. The following information appears in the left pane:  
ERP Event Name  

This is the name of the EnterpriseOne outbound event.  

11. Select the event. The system loads the event fields in the bottom pane.  
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For the Workflow events, the system loads and displays a single event field in the bottom 
pane, as shown below. 

 

12. Save the Notification Service.  

13. Review the information that appears on the following tabs:  
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Adapter Settings Tab 
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• Adapter Name 

The adapter that owns the Notification Service.  

• Adapter Listener Name  

The event listener for the Notification Service.  

• Adapter Notification Template  

The adapter template used for the Notification Adapter Service.  

Permissions Tab 

 

• List ACL  

Users in the allowed list can see that the elements exist and view the metadata (input, 
output, and so on) for the elements.  

• Read ACL 

Users in the allowed list can view the source code and metadata for the element.  

• Write ACL 

Users in the allowed list can lock, edit, rename, and delete the element.  

• Execute ACL 

Users in the allowed list can execute the service.  
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• Enforce Execute ACL 

The value in for this field include: For top-level service only, Always.  

• ACL Information 

Click to view the users and groups that compose the ACLs on the Integration Server to 
which you are connected. This information is read only. To edit ACLs, users, and 
groups, use the Integration Server Administrator. 

14. Enable the Notification service.  

a. Using the Admin tool (Adapter > EnterpriseOne Adapter >Listeners), check whether 
the Listener is enabled. If enabled, click the Yes link to disable the Listener. 

 
b. Click Listener Notifications on the left side of the screen. 
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c. Enable the Notification by clicking the No link  

 

d. Click Listeners on the left side of the screen. 

e. Enable the Listener by clicking the No link. 

Now the adapter is ready to receive, process, and publish the real-time event required 
by the notification service. 

15. Check in the notification service to the Source Control System. 
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Disabling the Notification 

Important  

To ensure that the notification is pushed to the listener, you must perform the following 
procedure when checking in the notification service. If you do not perform this procedure, the 
imported notification service will not be registered with the listener, and the adapter will not 
receive the real-time events. 

 

► To disable the notification 

 
1. Using the Admin tool (Adapter > EnterpriseOne Adapter > Listener Notifications), disable 

the notification by clicking Yes in the Enabled column. 
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2. Using the Admin tool (Adapter > EnterpriseOne Adapter > Listeners), disable the 

listener. 

3. Check in the artifacts to the Source Control System. 

 

Flow Services  

A Flow Service describes the interaction between the integration tasks. It ties the integration 
logic together. This is where the system creates the actual logic. The flow generates the WSDL 
for the web service.  

You call the adapter services in the flow to execute the business logic.  

► To create a Flow Service 

1. From the File menu, select New, and then Flow Service.  

2. Click Next.  

3. Name your Flow Service following naming standards in the EnterpriseOne XPI 8.94 
PeopleBook: Integration Development Methodology. 

4. Place the Flow Service in the flow service package. 
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5. Select one of the starter flows, and then click Finish. The default is empty. 

6. Select the flow. Add in the steps to process the Notification document.  

 

7. Go to the input/output tab and select the input and output documents for the flow. If you 
are creating a flow that processes a notification, then select the publish document that 
was created for the Notification Service.  

For this example, there is a step to call a service to Save the Pipeline to a File. The input 
to the flow service is the publish document for a Notification Service.  
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8. In the Pipeline tab, scroll to the SavePipelineToFile service. The input to this service is a 
file name and location:  

  

Trigger  

A trigger provides the link between the Notification Service and flow to execute when the real-
time event is received from EnterpriseOne. 

► To create a trigger 

1. From the File menu, select New, and then Trigger.  

2. Click Next.  

3. Name your trigger following naming standards in the EnterpriseOne XPI 8.94 
PeopleBook: Integration Development Methodology. 

4. Place the Trigger in the flow service package in a Triggers folder, and then click Finish. 

The following information appears in the left pane:  
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Item Description 
Name The name of the condition for the trigger. For example,  invoke. 

Service The name of the flow service that executes when a real-time event is 
triggered. 

Document Types The publish document that was created when you created the Notification 
Service. 

Join Type This field displays N/A until you specify more than one publishable document 
type. 

 

 

5. Type the condition name, for example invoke_notifySalesOrder.  

6. Select the flow service to run when a real-time event is triggered.  

7. For the document type, select the Publish document that was created when you created 
your Notification Service. This publish document must match the name of the event; that 
is, if the event name is notifySalesOrder in the AdapterServices folder, then the publish 
document must be AdapterServices:notifySalesOrderPublishDocument.  
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Note  
The document type should be the same as the document type input for your flow 
service.  

 

 

8. Save your trigger.  
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Samples  

The samples in this section show examples of adapter services that were built using the 
PeopleSoft EnterpriseOne adapter templates. The samples illustrate how the adapter services 
can be used in a flow.  

• EnterpriseOne adapter service to call an EnterpriseOne business function 

• EnterpriseOne adapter service to call an EnterpriseOne Select database operation 

• Notification adapter service from EnterpriseOne that is triggered by an EnterpriseOne 
real-time event  

• Transactions are a flow that show how to start, commit, and rollback a transaction  

• EnterpriseOne adapter service to execute a XML List operations 

Prerequisite  
 The tests require that you install and activate the 

PSFT_EnterpriseOne_AdapterSamples package, and that dependent packages have 
been installed and activated. If you have not installed and activated the packages, refer 
to the list in the Introduction section of this document.  

 Ensure that you are viewing and running the correct artifact for your connection. 
PeopleSoft provides sample artifacts for both EnterpriseOne and ERP8 connections.  

 For ERP8 business function calls, you must first generate the Java wrappers and note 
the location of the jar files in your ERP8 connection configuration. For more information, 
see the PeopleSoft EnterpriseOne XPI 8.94 Installation and Configuration for 
EnterpriseOne Adapter.  

 For EntepriseOne and ERP8 notifications, the PSFT_EnterpriseOne_AdapterSamples 
package contains default listeners. Before running the notification samples, you must 
configure the listeners to work with your environment, as well as enable the listener and 
listener notification. For more information, see the PeopleSoft EnterpriseOne XPI 8.94 
Installation and Configuration for EnterpriseOne Adapter.  
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Sample #1 – Adapter Service to call an EnterpriseOne Business Function  

The PSFT_EnterpriseOne_AdapterSamples package includes Adapter Services for business 
function calls to AddressBook MBF. The package includes adapter services for both an 
EnterpriseOne connection and an ERP8 connection. You must ensure that you are viewing and 
executing the correct flows and adapter services for your connection.  

Address Book Add  

► To review the flow 

1. Select the addAddressBook flow service under the Business Function folder, and then 
click the Input/Output tab.  

 

The input is a reference to the ProcessAddressBook document. The output is a 
reference to the ConfirmAddressBook document. The documents are located in the docs 
directory under BusinessFunction.  
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2. Click the Flow tab. The first step in the flow is a DeclareGlobals step that defines 
constant values that are mapped in the pipeline later in the flow.  

 

3. The second step is a call to the AddressBookMBF adapter service. Click the Pipeline tab 
to view the mappings.  
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4. The next step is a Loop over the phone number array. Select the Loop, and then view 
the properties in the Properties tab.  

 

5. The next step within the loop is a call to the AddChangeElectronicAddressPhone 
adapter service. This adapter service maintains phone and email records in 
EnterpriseOne. Click the Pipeline tab to view the mappings.  
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6. The next step is a loop over the Electronic Address array. Select the loop, and then view 
the properties in the Properties tab.  

Running the Flow 

► To run the flow 

 

1. From the Test menu, select Run.  
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A screen with the input parameters to the flow service appears.  

2. Select Load and pull in the test script ABPhoneEmail. You can find the test scripts in the 
PSFT_EnterpriseOne_AdapterSamples package. To get to this package in the file 
system, go to the following directory: 

x:\<xpi_install_dir>\IntegrationServer\packages\PSFT_EnterpriseOne_Adap
terSamples\pub\doc\testscripts 

where x is the drive where XPI was installed  

 

3. Select the ABPhoneEmail test script, and then click Open. 

The system loads the input parameters.  

4. Click OK.  

 

5. The flow service runs, placing the confirm document in the Results tab with the newly 
assigned address book number. 
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Sample #2 – Adapter Service to call an EnterpriseOne Select database 
operation  

The PSFT_EnterpriseOne_AdapterSamples package includes Adapter Services for executing a 
database select query against the F0101 EnterpriseOne table. Before you run this sample, you 
must ensure that the EnterpriseOne connection is enabled.  

Select Database Query.  

► To review the adapter service 

1. Select the AddressBookQuery service under the AdapterServices folder, and then click 
the Select tab.  

 

This service is configured to perform a query against the F0101 Table and retrieve nine 
fields (AN8, ALPH, DC, USER, PID, UPMJ, JOBN, UPMT, USER). At the bottom of the 
tab, notice that the Max Rows is set to 10 to limit the number of results. 

2. Select the WHERE tab to examine the where clause for this query service. 
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There are three where clause rows for this query. In SQL, this query would generate the 
following: 

(ALPH LIKE 'PeopleSoft' OR (AN8 > '1000' AND AN8 < '2000))' 

Remember, the very first AND/OR value does not matter. The two AN8 rows are 
grouped together because both are given the same grouping level of “(“.  

Running the Adapter Service 

Adapter Services can be run just like any service on the system. 
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► To run the Select query 

 

1. From the Test menu, select Run.  

A screen with the input parameters to the flow service appears.  

 

2. For each parameter, enter the following values: 

24. INPUT_AN8_Lower – 1000 

25. INPUT_ALPH – PeopleSoft 
26. INPUT_AN8_Higher – 2000 
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Note 
Optionally, you can enter your own values and run the query. With the Max Rows set to 
10, you will never retrieve a large result set. 

 

3. Click OK to execute the query.  

4. Click OK.  

After the query is complete, the view changes to the Results tab. 

 

5. Click the resultSet document array. The system displays all of the documents in the grid 
at the bottom of the screen. 
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Sample #3 – Notification Service for Outbound Event  

The PSFT_EnterpriseOne_AdapterSamples package contains a Notification Service for the 
RTSOOUT real-time event in EnterpriseOne. This package also contains the listener and 
associated trigger. These notification services were created with both an EnterpriseOne 
connection and an ERP8 connection. You must ensure that you are viewing and running the 
correct notification services and flows for your connection.  

Sales Order Notification  

► To review the flow 

 

1. Open the Adapter Services folder, and then select the notifySalesOrder notification 
service. This is a notification service for the RTSOOUT real-time event in EnterpriseOne.  
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2. Open the notifySalesOrderPublishDocument. This is the interface document that was 
created for the notification service by the EnterpriseOne adapter.  

 

3. Open the Notifications folder, the triggers folder, and then select the trigger. This trigger 
causes the flow service to run.  
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4. Select the notifySalesOrder flow service under the Notifications folder. When run, this 
trigger initiates the flow service. Subsequently, the flow copies the real-time event XML 
in the pipeline to a file, in which you can view the XML.  

Running the Flow 

► To run the flow 

1. To trigger the notification, you must sign in to the EnterpriseOne or ERP8 environment 
and enter a Sales Order. Entering the Sales Order produces a real-time event. The 
trigger processes this real-time event and runs the flow service, which writes the event 
XML to a file.  

The system writes the file to the C drive and names it SalesOrder.log. For ERP8, the file 
is named SalesOrder_ERP8.log.  

2. If you would like the file to be written to a different location, you must change the location 
on the savePipelineToFile service. Go to the pipeline for the service call and scroll to the 
input to the service.  
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3. Right-click the filename and select ModifyValue.  

 

4. On Input for ‘fileName,’ type the location and name of the file.  

5. Select the following option: 

27. Overwrite pipeline value 

6. Click OK, and then save the flow service.  

7. Find and open the file to view the XML.  
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Sample #4 – Transactions  

Multiple Address Book adds  

This sample is a flow that calls the AddressBookMBF adapter service multiple times. The last 
execution of the adapter service does not map the alpha name. This is a required parameter for 
the AddressBookMBF and will cause the business function to fail. The flow catches the 
exception and rolls back the address book records that were added before the failed adapter 
service execution.  

► To review the flow 

1. Open the Transaction folder in the PSFT_EnterpriseOne_AdapterSamples package. 
Select the multipleAddressAdd flow.  

 

2. The first step in the flow is a GenerateKey service. When you start a transaction, you 
must give the new transaction a unique name to distinguish it from other transactions in 
the system. Since a single flow may be called by multiple threads at the same time, you 
must give the transaction a unique name.  

To assist in generating a unique name, inside the PSFT_E1_Adapter package is the 
following service:  

PSFT_E1_Adapter.enterpriseone.services:GenerateKey  

Whenever this service is called, it returns a unique value that should be used as the 
input for a transaction.  
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3. The next step in the flow is startTransaction. Click the startTransaction, and then click 
the Pipeline tab. Scroll to the startTransaction input and output parameters. The unique 
key generated by the GenerateKey service is mapped into the startTransaction 
parameter.  

 

The third and fourth steps in the flow are a call to the AddressBookMBF adapter service. 
They have been mapped to send the necessary information and will complete 
successfully. The fifth step is a sequence step to provide a Try/Catch block. The call to 
the AddressBookMBF adapter service has been mapped to not include the alpha name. 
This causes an error. The error will be caught in the Catch section of the Sequence step 
and will execute the rollback transaction.  

4. Select the commitTransaction and the Pipeline tab.  

5. Scroll to the commitTransaction input and output parameters. When calling the 
commitTransaction service, you must specify the same name that you used in the 
startTransaction.  

6. Select the rollbackTransaction and the Pipeline tab.  

7. Scroll to the rollbackTransaction input and output parameters. When calling the 
rollbackTransaction service, you must specify the same name that you used in the 
startTransaction.  
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Running the Flow 

► To run the flow 

 

1. From the Test menu, select Run.  

A screen with the input parameters to the flow service appears.  

2. Click Load and pull in the test script TesttranAB. You can find the test scripts in the 
PSFT_EnterpriseOne_AdapterSamples package. You can use the same test script for 
both EnterpriseOne and ERP8 environments.  

3. To get to this package in the file system, go to 

x:\PeopleSoft\xpi\IntegrationServer\packages\PSFT_EnterpriseOne_A
dapterSamples\pub\doc\testscripts  

where x is the drive where XPI is installed.  
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4. Select the TesttranAB test script and click Open. 

The system loads the input parameters.  

5. Click OK. The flow service runs and displays the following exception:  

 

6. To check that the first two address book records were rolled back, you can look at the 
log. To find the log in the file system, go to the following directory: 

For EnterpriseOne: 

x:\PeopleSoft\xpi\IntegrationServer\logs\EnterpriseOneAdapter\jas
debug_date.log 

where x is the drive where XPI is installed  

For ERP8: 

x:\PeopleSoft\xpi\IntegrationServer\logs\ERP8Adapter\jasdebug_dat
e.log 

The log file contains the following information:  

EnterpriseOne Log File 

14 Nov 2003 11:01:22,181 [HTTP Handler 127.0.0.1] DEBUG: 

{com.jdedwards.system.kernel} - CallObject@17f9037: complete in 691ms 

BSFN:AddressBookMasterMBF user:KL5449350 Env:PY9NIS2 ManTran:true RTC-

hasCache:false CO-hasCache:false 

 

14 Nov 2003 11:01:22,181 [HTTP Handler 127.0.0.1] DEBUG:  

{com.jdedwards.system.connector} - Call BSFN method 

PeopleSoft Proprietary and Confidential 121 



EnterpriseOne Adapter Programmer Guide 

N0100041.AddressBookMasterMBF completed 

 

14 Nov 2003 11:01:22,251 [HTTP Handler 127.0.0.1] ERROR:  

{com.jdedwards.system.connector} - BSFN N0100041.AddressBookMasterMBF execution 

fail 

 

14 Nov 2003 11:01:22,661 [HTTP Handler 127.0.0.1] DEBUG:  

{com.jdedwards.system.kernel} - RemoteUser: rollback complete, 

host:CRMW2K2:6025, kernel PID:3908 h:c8657a0a 

 

14 Nov 2003 11:01:22,661 [HTTP Handler 127.0.0.1] DEBUG:  

{com.jdedwards.system.kernel} - RemoteUser: free, host:CRMW2K2:6025, kernel 

PID:3908 h:c8657a0a 

 

14 Nov 2003 11:01:22,661 [HTTP Handler 127.0.0.1] DEBUG:  

{com.jdedwards.system.connector} - Oneworld Transaction 

com.jdedwards.system.connector.dynamic.OneworldTransactionImpl@15589d4 rollback 

ERP8 Log File 

2003-11-14 10:54:14.406 [HTTP Handler 127.0.0.1] KERNEL  : CallObject@1719660: 

complete in 431ms BSFN:AddressBookMasterMBF user:MS7116364 Env:DV7334NIS2 

ManTran:true RTC-hasCache:false CO-hasCache:false 

 

2003-11-14 10:54:14.786 [HTTP Handler 127.0.0.1] KERNEL  : RemoteUser: rollback 

complete, host:CRMW2K2.MLAB.JDEDWARDS.COM:6055, kernel PID:5076 h:c8646704 

 

2003-11-14 10:54:14.786 [HTTP Handler 127.0.0.1] KERNEL  : RemoteUser: free, 

host:CRMW2K2.MLAB.JDEDWARDS.COM:6055, kernel PID:5076 h:c8646704 

Sample #5 – Adapter Service for XML List Operations 
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The PSFT_EnterpriseOne_AdapterSamples package contains a Adapter Service that uses 
Create, Retrieve, and Delete XML List operations. This adapter service was created for an ERP8 
connection only. You must ensure that you are viewing and running the correct notification 
services and flows. 

AddressBook 

► To review the flow 

 

1. Open the Adapter Services folder, and then select the AddressBookList service. This is 
a service for the address book query using list API.  
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2. Click the Input/Output tab and notice the input parameters for the list template. The 
value that gets passed to the template through these parameters determines the 
operations the template will perform. The sample demonstrates how the template 
performs all three operations: create list, retrieve list, and delete list.  

3. View the mapping in the lower plane. 

 

Running the Flow 

► To run the flow 

1. Select AddressBookQuery under XMLListQuery, and then click the RUN button. 

 

2. Enter the above shown values, and then click OK. 
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3. View the results in the Results tab. 
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Resolving Adapter Problems  

This section discusses the following topics: 

• Logging 

• Errors 

Logging 

Several log files provide assistance with resolving problems if the adapter is not functioning 
correctly:  

You can find the logs in the following location:  

x:\xpi install dir\IntegrationServer\logs\  

where x is the drive where XPI is installed  

EnterpriseOne Adapter Logs 

When using an EnterpriseOne connection, the EnterpriseOne Adapter directory creates the 
following five logs:  

• jasdebug_date.log  

Use this log for information about the dynamic connector and the execution of the 
business functions. This is also where you can find information about connections, 
and rollback and commit of transactions.  

• jas_date.log 

Use this log for information about the dynamic connector connection to 
EnterpriseOne.  

• rt.log  

Use this log for information about the EnterpriseOne real-time events.  

• rtdebug.log  

Use this log for debug information about the EnterpriseOne real-time events.  

• jderoot_date.log 

Use this log for basic information about the EnterpriseOne connection.  

ERP8 Adapter Logs 

When using an ERP8 connection, the ERP8 Adapter directory contains the following four 
logs:  

• jasdebug.log  
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Use this log for information about the java connector and the execution of the 
business functions. This is also where you can find information about connections, 
and rollback and commit of transactions.  

• jas.log  

Use this log for information about the Java connector connection to ERP8. 

• rt.log  

Use this log for information about ERP8 real-time events.  

• rtdebug.log  

Use this log for debug information about ERP8 real-time events.  

Errors 

This section contains some of the common errors that can occur when programming the 
adapter, along with instructions on how to remedy each error. 

Error Configuring a Listener  

You might receive the following error when you configure a listener. However, the error does 
not prohibit the configuration from occurring. The error is related to the version of Internet 
Explorer on which the Integration Server is run. Click No and the configuration will complete.  
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Error When Creating a Notification Service 

You might receive the following error when you create a notification service in Integration 
Developer. This occurs when the connection is lost to EnterpriseOne or ERP8. If you receive 
this error, you must delete the partial notification service from your package using the file 
system. Use the Integration Server Administration tool to reload the package you were 
adding the notification service to and create the notification service again.  

 

  

Adapter is Not Picking Up Real-Time Events 

The Adapter will not pick up real-time events if the notification is not pushed to the listener.  
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► To make sure the notification is pushed to the listener 

 

1. In the Developer tool, identify the listener that is attached to the notification service. 
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2. In the Admin tool, under Adapter > EnterpriseOne Adapter > Listeners, click the View 
button next to the listener. 
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3. Click the View Notification Order link. 

 

4. Verify that the notification is listed in the Notification Order list box 

Note 
See step 17, “Check in the notification service to Source Control System,” in the To 
create a notification service section to avoid this issue. 

 

Adapter Runtime (Notification): Error Publishing Notification 

If you see the following error in the server log, the broker document is not synchronized with 
the Integration Server document:  

[ART.116.3010] Adapter Runtime (Notification): Error publishing 
notification 
AdapterServices.Notification.Supplier:notifySupplierEvent. 
Error: [ISS.0098.9014] BrokerException: Unknown Document Type 
(226-1490): Document type 
'wm::is::AdapterServices::Notification::Supplier::notifySupplier
EventPublishDocument' is not defined in the Broker. . 
[ISS.0098.9014] 

Use the Developer tool to synchronize this document with the broker.  

► To synchronize the document with the Broker 

1. Open XPI Developer and connect to the same Integration Server environments to 
which you installed the Integration Points.  
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2. From the File menu, select Sync Document Types, and then All Out-of-Sync. 

 

3. For each document type that is listed, verify that the value in the Action column is 
Push to Broker.  

4. Click the Synchronize button. 

PeopleSoft Proprietary and Confidential 133 



EnterpriseOne Adapter Programmer Guide 

Error Retrieving Large Records Using List Template 

If the Integration Server runs out of memory while retrieving a large number of records, the 
following message appears in the Developer tool: 

 

In addition, the server log does not indicate the response for the retrieve list operation, as 
shown in the following example: 

2004-03-22 14:45:51 MST [ADA.7180.7070D] Response received from ERP server 

for create list request:-"XML Request OK"  

2004-03-22 14:45:51 MST [ADA.7180.7066D] Create List execution complete. 

List handle:-"lrj405f5f06007c-00000a34-00000003-

00000000000000000000ffff0ae6fc" List Size:- "6272" 

 

2004-03-22 14:45:51 MST [ADA.7180.7064D] Executing GetGroup (Retrieve)  List 

Operation  

 

2004-03-22 14:45:51 MST [ADA.7180.7073D] Sending the Retrieve (GetGroup) 

Request to ERP server  "<?xml version="1.0" ?> 

 

<jdeRequest type="list" user="UR6864969" pwd="UR6864969" 

environment="DV7334NIS2" session="" sessionidle="" > 

 

<ACTION TYPE="GetGroup"> 

 

<HANDLE VALUE="lrj405f5f06007c-00000a34-00000003-

00000000000000000000ffff0ae6fc"/> 

 

<FROM VALUE="1"/> 

 

<TO VALUE="6272"/> 

 

</ACTION> 

 

</jdeRequest>" 

 

The Integration Server error log indicates only null, as shown in the following example: 

                     com.wm.pkg.art.error.DetailedServiceException: 

[ART.117.4002] Adapter Runtime (Adapter Service): Unable to invoke adapter 

service services:ListQuery. 
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null 

 

 at 

com.wm.pkg.art.error.DetailedServiceException.create(DetailedServiceExceptio

n.java:125) 

 

To solve this problem, you can increase the amount of memory on the Integration Server, 
and set up the system to retrieve records in chunks. 

► To increase amount of memory on the Integration Server 

1. Stop the Integration Server. 

2. Go to the following location: <Integration server install dir>\bin.  

3. Open the server.bat file for edit.  

4. In the SETLOCAL section, change the JAVA_MAX_MEM setting to a higher value 
depending on the requirement of your system. For example, change the following 
setting: 

From: 

set JAVA_MAX_MEM=256M 

To:  

set JAVA_MAX_MEM=512M 

5. Save the file 

6. Restart the Integration Server. 

► To retrieve records in chunks 

You can set the system to retrieve records in chunks by providing the correct input values 
to Start Index, Last processed Index, and/or End Index. 

Errors Changing the Data Selection Parameters in List Template 

You might encounter the following List Template errors. 

• Sequence Name does not match.  

 

PeopleSoft Proprietary and Confidential 135 



EnterpriseOne Adapter Programmer Guide 

136  PeopleSoft Proprietary and Confidential   

• Data Selection Operand Field does not appear or will not change when the Operator 
is changed. 

 

► To resolve the List Template errors 

1. Delete the data selection row using the Remove Row button, and then add it back 
using the Add Row button.  

2. Select the correct operator. 
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	The PeopleSoft EnterpriseOne Adapter enables the exchange of information between PeopleSoft EnterpriseOne and other heterogeneous systems. This adapter provides a flexible, easy-to-use mechanism for XPI-enabled applications to interface with PeopleSoft E
	The EnterpriseOne Adapter exposes business logic, real-time event generation, and database access within EnterpriseOne.
	This guide is primarily for the developer who is responsible for creating adapter services that enable interoperability with PeopleSoft EnterpriseOne. The guide contains sample scenarios that you can view and use to assist in creating adapter services an
	To view and run the sample scenarios you must:
	Configure the PeopleSoft EnterpriseOne Adapter to connect to EnterpriseOne. When you install the adapter, default configurations are set up for the EnterpriseOne and ERP8 environments that you can edit to connect to your EnterpriseOne or ERP8 environment
	Configure and enable a listener for real time events in your EnterpriseOne or ERP8 environment. Sample listeners have been created in the PSFT_EnterpriseOne_AdapterSamples package. You must reconfigure the listener to use your EnterpriseOne or ERP8 envir
	Make sure that the PSFT_EnterpriseOne_AdapterSamples package, that was installed with the adapter, is activated.
	Install and activate the following packages:
	PSFT_XrefAndSoftCoding
	PSFT_Utils
	Use PeopleSoft XPI Integration Developer to view and run the samples.
	Note
	The sample artifacts are built for both EnterpriseOne and ERP8 connections. Ensure that you are viewing and running the correct artifact for your connection.
	EnterpriseOne XPI 8.94 Installation and Configuration for EnterpriseOne Adapter
	Elements of Integration Developer
	You should be familiar with EnterpriseOne XPI products, particularly the Integration Developer. Integration Developer is used to create the adapter services and flows.
	The elements involved in using the Integration Developer are:
	Creating packages
	Creating folders
	Creating interface documents
	Adapter services
	Notification services
	Flow services
	Trigger
	
	Creating Packages


	A package is a logical container for a set of services and related files. It exists as a single physical directory on the file system.
	To create a package
	From the File menu, select New, Package, and then Next.
	Name your package using the integration development standards.
	EnterpriseOne XPI 8.94 PeopleBook: Integration Development Methodology
	
	Creating Folders


	A folder is a logical container for a set of artifacts within a package. The top-level folder is named the same as the package name to avoid naming conflicts. Additional folders are provided for each of the artifacts (such as docs, triggers, and utils)
	To create a folder
	From the File menu, select New, Folder, and then Next.
	Name your high-level folder the same as the package name.
	Create folders for the associated artifacts, using the integration development standards.
	
	Creating Interface Documents


	Interface documents provide the input and output to the flow services. You can create interface documents as part of creating a flow service, or you can create them as a separate activity. The following components make up the structure of an interface do
	Document/Document List  –  Documents/Document Lis
	s of related fields. Any grouping within the interface document is defined as a Document or Document List. Examples are:
	Header – document
	Line – document list
	Fields – Fields are the lowest level elements def
	The interface document is the input and output for the web service generated from the flow. XPI Integration Developer requires that all fields defined in the document be of a string type. When defining the interface document, define the field as a string
	To create an interface document
	From the File menu, select New, and then Document Type.
	Click Next.
	Name your Interface Document and place it in the Docs folder for your package.
	Select a source.
	Create a document structure.
	
	Adapter Services


	An Adapter Service is created from an operation template to perform a specific operation on a resource. For example, the EnterpriseOne adapter provides a template for performing business functions calls. This is how the adapter transfers data and communi
	
	
	Business Function Template



	The Business Function Template has built-in hooks for calling EnterpriseOne business functions. You can use one template for several operations, so the adapter may have many adapter services. Each adapter service is a one-to-one mapping to a business fun
	To create an Adapter Service
	From the File menu, select New, and then Adapter Service.
	Click Next.
	�
	Select EnterpriseOne Adapter, and then click Next.
	�
	On New Adapter Service, select either EnterpriseOne or ERP8, and then click Next.
	�
	Select a business function template, and then click Next.
	Name your Adapter Service following the naming standards in the EnterpriseOne XPI 8.94 PeopleBook: Integration Development Methodology.
	Place the Adapter Service in an Adapter Services package, and then click Finish.
	Select the newly created Adapter Service.
	The following information appears in the right pane under the Business Function tab:
	EnterpriseOne Connection
	Description
	Library Name
	The name of the DLL in EnterpriseOne to which the business function belongs.
	Interface Name
	The name of the C module or NER in EnterpriseOne.
	Business Function Name
	The name of the business function in EnterpriseOne.
	Typed or String input fields
	Defines the type of the input document fields. If specified to Typed, the input document will contain typed fields, such as Double, Character, Date, which match the BSFN data structure fields. If specified as String, the input document fields will be Str
	Note: Below the information about the business function, you will find the input data structure parameters and the output data structure parameters.
	Typed or String output fields
	Defines the type of the output document fields. If specified to Typed, the output document will contain typed fields, such as Double, Character, Date, which match the BSFN data structure fields. If specified as String, the output document fields will be
	�
	Click the drop-down menu in each of the following fields and select the appropriate values for each:
	Library Name
	Interface name
	Business Function Name
	Typed or String Input Fields
	Under the BSFN Input Field Names area, select one value at a time or select all.
	Click the Typed or String Output Fields drop-down menu and select one value at a time or select all.
	Your finished adapter service should look like the following example:
	�
	Save the Adapter Service.
	ERP8 Connection
	Description
	Library Name
	The Java wrapper jar name to which the business function belongs
	Interface Name
	The grouping name within the Java wrapper
	Business Function Name
	The name of the business function in ERP8
	Typed or String input fields
	Defines the type of the input document fields. If specified as Typed, the input document will contain typed fields, such as Double, Character, and Date, which match the BSFN data structure fields. If specified as String, the input document fields will al
	Note: Below the information about the business function, you will find the input data structure parameters and the output data structure parameters.
	Typed or String output fields
	Defines the type of the output document fields. If specified as Typed, the output document will contain typed fields, such as Double, Character, Date, which match the BSFN data structure fields. If specified as String, the output document fields will all
	Click the drop-down menu in each of the following fields and select the appropriate values for each:
	Library Name
	Interface name
	Business Function Name
	Typed or String Input Fields
	Under the BSFN Input Field Names area, select one value at a time or select all.
	Click the Typed or String Output Fields drop-down menu and select one value at a time, or select all.
	Your finished adapter service should look like this:
	�
	Save the Adapter Service.
	Review the information that appears on the following tabs:
	Adapter Name
	The name of the adapter.
	Adapter Connection Name
	The name of the connection specified when the adapter service was created.
	Adapter Service Template
	The name for the adapter template used to create the adapter service.
	�
	Input
	The input interface document for the adapter service. This is the list of input parameters selected from the business function parameters.
	Part of the input is a Control structure that contains three parameters,TruncateStrings, dateFormat, and stripTrailingBlanks. When TruncateStrings is set to True, this parameter tells the adapter to either truncate string values to the length specified i
	Note
	This parameter only exists on EnterpriseOne Business Function services.
	The dateFormat parameter tells the adapter how to format String values into dates. The format applies to both input and output date values. The default format for dates is: MM/dd/yyyy. Where MM = months, dd = days, yyyy = years.
	Note
	The case of this format is important. MM/dd/yyyy does not equal mm/dd/yyy and does not equal MM/DD/YYYY.
	The stripTrailingBlanks parameter tells the adapter to strip any trailing blanks from returned values. By default this value is False. Values which contain only blanks (spaces), will not be modified.
	Output
	The output interface document for the adapter service. This is the list of output parameters selected from the business function parameters.
	In addition to the output parameters, there is a HasWarnings boolean field and a WarningMsgs string array field. If the executed business function returns a warning (a return code of 1), the HasWarnings field will be set to True. When set to True, the 
	If the business function returns an error (a return code of 2) the adapter throws an exception into the Flow. This exception should be caught with a Try/Catch block. It is possible for a BSFN to return error messages but report back a return code of su
	�
	On the Settings tab, the system defines the template file associated with the selected service, assigns run-time parameters, and assigns a universal name. This is currently not used by the EnterpriseOne adapter.
	�
	Enable Service Auditing
	The Enable Service Auditing section defines how you want to audit. Values include: Never, For top-level service only, Always.
	When to log
	This section defines when to log. Values include: Errors only, Error and Success, Error, Success and Start.
	When to include input pipeline
	This section defines when to include the pipeline in the log. Values include: Never, On errors only, Always.
	�
	List ACL
	Users in the allowed list can see that the elements exist and view the elements metadata (input, output, and so on).
	Read ACL
	Users in the allowed list can view the source code and metadata for the element.
	Write ACL
	Users in the allowed list can lock, edit, rename, and delete the element.
	Execute ACL
	Users in the allowed list can run the service.
	Enforce Execute ACL
	This field’s values include: For top-level Servic
	ACL Information
	Click to view the users and groups that compose the ACLs on the Integration Server to which you are connected. This information is read only. To edit ACLs, users, and groups, use the Integration Server Administrator.
	�
	When testing and debugging in the XPI Integration Developer tool, the results of the service appear in this tab.
	�
	
	
	Select Template



	The Select Template enables you to execute a Select database operation against any table or business view in the EnterpriseOne database. The system performs all scrubbing operations (such as decimal shifting, date conversion, and so on) before the data
	To create an Adapter Service
	From the File menu, select New, and then Adapter Service.
	Click Next.
	�
	Select EnterpriseOne Adapter, and then click Next.
	�
	On New Adapter Service, select EnterpriseOne, and then click Next.
	�
	Select the Select template, and then click Next.
	Name your Adapter Service following the naming standards in the EnterpriseOne XPI 8.94 PeopleBook: Integration Development Methodology.
	Place the Adapter Service in an Adapter Services package, and then click Finish.
	Select the newly created Adapter Service.
	The following information appears in the right pane under the Select tab:
	EnterpriseOne Connection
	Description
	Type
	Determines whether the query will run against a table or a business view
	Name
	The name of the table or business view.
	Description
	A non-editable field that contains the description of the selected table or business view.
	All or Distinct
	Allows you to choose whether the query will return All rows or whether it will return only Distinct rows.
	Note: The table or business view column information appears below the All or Distinct drop-down box.
	Max Rows
	The maximum number of rows to return in the query. A less than (<) or equal (=) to zero (0) will return all rows.
	�
	Click the drop-down menu in each of the following fields and select the appropriate values for each:
	Type
	Name
	All or Distinct
	Under the Column information area, select one value at a time or select all.
	Note
	For performance reasons, you should only select the columns for which you need data returned.
	For any row that has a Field Type other than String, you may select the Field Type box and select the default data type (such as Double, Date, and so on) and change it to a String. This changes the data type of the output field for this row.
	Your finished adapter service should look like this example:
	�
	Save the Adapter Service.
	Click the WHERE tab.
	�
	This tab allows you to create a Where clause that filters the data in a query.
	Select the Insert Row to add a Where clause line.
	Select AND/OR to determine how this line is applied to the line above it. The AND/OR value for the first line does not matter.
	Under the Left Grouping column, select the grouping level for the line. By placing multiple Where clause lines at the same grouping level, you can build up complex Where clauses.
	Select the column to apply the Where clause filter to.
	Select the operator.
	Select the input field for the filter value. You can rename this field.
	Repeat these steps for as many Where clause lines are needed.
	Review the information that appears on the following tabs:
	Adapter Name
	The name of the adapter.
	Adapter Connection Name
	The name of the connection specified when the adapter service was created.
	Adapter Service Template
	The name for the adapter template used to create the adapter service.
	�
	Input
	The input interface document for the adapter service. This will be the set of parameters required for the created Where clause.
	Part of the input is a Control structure that contains three parameters, dateFormat, stripTrailingBlanks, and overrideMaxRows. The dateFormat parameter tells the adapter how to format String values into dates. The default format for dates is: MM/dd/yyyy.
	Note
	The case of this format is important. MM/dd/yyyy does not equal mm/dd/yyy and does not equal MM/DD/YYYY.
	The stripTrailingBlanks parameter tells the adapter to strip trailing blanks from values returned in the result set. The default value for this parameter is False. Returned values that contain only blanks (spaces) will not be modified.
	The overrideMaxRows parameter allows you to pass in an integer value to override the maximum number of rows that the adapter returns at runtime. If the adapter template is set at design time to return 10 rows, at runtime this value can be changed to 100,
	Output
	The output interface document for the adapter service. This contains a resultSet array that has fields for every column selected.
	If an error occurs while executing the Select query, the adapter throws an exception into the Flow. This exception should be caught with a Try/Catch block.
	�
	On the Settings tab, the system defines the template file associated with the selected service, assigns run-time parameters, and assigns a universal name. This is currently not used by the EnterpriseOne adapter.
	�
	Enable Service Auditing
	The Enable Service Auditing section defines how you want to audit. Values include: Never, For top-level service only, Always.
	When to log
	This section defines when to log. Values include: Errors only, Error and Success, Error, Success and Start.
	When to include input pipeline
	This section defines when to include the pipeline in the log. Values include: Never, On errors only, Always.
	�
	List ACL
	Users in the allowed list can see that the elements exist and view the elements metadata (input, output, and so on).
	Read ACL
	Users in the allowed list can view the source code and metadata for the element.
	Write ACL
	Users in the allowed list can lock, edit, rename, and delete the element.
	Execute ACL
	Users in the allowed list can run the service.
	Enforce Execute ACL
	This field’s values include: For top-level servic
	ACL Information
	Click to view the users and groups that compose the ACLs on the Integration Server to which you are connected. This information is read only. To edit ACLs, users, and groups, use the Integration Server Administrator.
	�
	When testing and debugging in the XPI Integration Developer tool, the results of the service appear in this tab.
	�
	
	
	Insert Template



	The Insert Template allows a user to execute an Insert database operation against select tables or business views in the EnterpriseOne database. Insert operations are limited to specified interface tables (Z tables) and F47 tables. The system performs 
	To create an Adapter Service
	From the File menu, select New, and then Adapter Service.
	Click Next.
	�
	Select EnterpriseOne Adapter, and then click Next.
	�
	On New Adapter Service, select EnterpriseOne, and then click Next.
	�
	Select the Insert template, and then click Next.
	Name your Adapter Service following the naming standards in the EnterpriseOne XPI 8.94 PeopleBook: Integration Development Methodology.
	Place the Adapter Service in an Adapter Services package, and then click Finish.
	Select the newly created Adapter Service.
	The following information appears in the right pane under the Insert tab:
	EnterpriseOne Connection
	Description
	Type
	Whether the Insert operation will run against a table or a business view
	Name
	The name of the table or business view.
	Description
	A non-editable field that contains the description of the selected table of business view.
	Note: The table or business view column information appears below the Description field.
	�
	Click the drop-down menu in each of the following fields and select the appropriate values for each:
	Type
	Name
	Under the Column information area, select one value at a time or select all.
	For any row that has a Field Type other then String, you may select the Field Type box and select either the default data type (such as Double, Date, and so on) and change it to a String. This changes the data type of the input field for this row.
	Your finished adapter service should look like the following example:
	�
	Save the Adapter Service.
	Review the information that appears on the following tabs:
	Adapter Name
	The name of the adapter.
	Adapter Connection Name
	The name of the connection specified when the adapter service was created.
	Adapter Service Template
	The name for the adapter template used to create the adapter service.
	�
	Input
	The input interface document for the adapter service. This document contains fields for all the selected columns. Each input document field will be titled the same as the selected column.
	Part of the input is a Control structure that contains one parameter - dateFormat. This parameter tells the adapter how to format String values into dates. The default format for dates is: MM/dd/yyyy. Where MM = months, dd = days, yyyy = years.
	Note
	The case of this format is important. MM/dd/yyyy does not equal mm/dd/yyy and does not equal MM/DD/YYYY.
	Output
	The output interface document for the adapter service. The output document contains a single field titled numRowsInserted, which returns the number of rows inserted. For the Insert template, this value is always one (1) when the insert operation comple
	If an error occurs while executing the Insert operation, the adapter throws an exception into the Flow. This exception should be caught with a Try/Catch block.
	�
	On the Settings tab, the system defines the template file associated with the selected service, assigns run-time parameters, and assigns a universal name. This is currently not used by the EnterpriseOne adapter.
	�
	Enable Service Auditing
	The Enable Service Auditing section defines how you want to audit. Values include: Never, For top-level service only, Always.
	When to log
	This section defines when to log. Values include: Errors only, Error and Success, Error, Success and Start.
	When to include input pipeline
	This section defines when to include the pipeline in the log. Values include: Never, On errors only, Always.
	�
	List ACL
	Users in the allowed list can see that the elements exist and view the metadata (input, output, and so on) for the elements.
	Read ACL
	Users in the allowed list can view the source code and metadata for the element.
	Write ACL
	Users in the allowed list can lock, edit, rename, and delete the element.
	Execute ACL
	Users in the allowed list can run the service.
	Enforce Execute ACL
	This field’s values include: For top-level Servic
	ACL Information
	Click to view the users and groups that compose the ACLs on the Integration Server to which you are connected. This information is read only. To edit ACLs, users, and groups, use the Integration Server Administrator.
	�
	When testing and debugging in the XPI Integration Developer tool, the results of the service appear in this tab.
	�
	
	
	Batch Insert Template



	The Batch Insert Template allows a user to execute a Batch Insert database operation against select tables or business views in the EnterpriseOne database. Batch Insert operations are limited to specified interface tables (Z tables) and F47 tables. The
	To create an Adapter Service
	From the File menu, select New, and then Adapter Service.
	Click Next.
	�
	Select EnterpriseOne Adapter, and then click Next.
	�
	On New Adapter Service, select EnterpriseOne, and then click Next.
	�
	Select the Batch Insert template, and then click Next.
	Name your Adapter Service following the naming standards in the EnterpriseOne XPI 8.94 PeopleBook: Integration Development Methodology.
	Place the Adapter Service in an Adapter Services package, and then click Finish.
	Select the newly created Adapter Service.
	The following information appears in the right pane under the Batch Insert tab:
	EnterpriseOne Connection
	Description
	Type
	Whether the Batch Insert operation runs against a table or a business view
	Name
	The name of the table or business view.
	Description
	A non-editable field that contains the description of the selected table or business view.
	Note: The table or business view column information appears below the Description field.
	�
	Click the drop-down menu in each of the following fields and select the appropriate values for each:
	Type
	Name
	Under the Column information area, select one value at a time or select all.
	For any row that has a Field Type other then String, you may select the Field Type box and select either the default data type (such as Double, Date, and so on) and change it to a String. This changes the data type of the input field for this row.
	Your finished adapter service should look like the following example:
	�
	Save the Adapter Service.
	Review the information that appears on the following tabs:
	Adapter Name
	The name of the adapter.
	Adapter Connection Name
	The name of the connection specified when the adapter service was created.
	Adapter Service Template
	The name for the adapter template used to create the adapter service.
	�
	Input
	The input interface document for the adapter service. This document contains fields for all of the selected columns. Each input document field is titled the same as the selected column.
	Part of the input is a Control structure that contains one parameter, dateFormat. This parameter tells the adapter how to format String values into dates. The default format for dates is: MM/dd/yyyy. Where MM = months, dd = days, yyyy = years.
	Note
	The case of this format is important. MM/dd/yyyy does not equal mm/dd/yyy and does not equal MM/DD/YYYY.
	Output
	The output interface document for the adapter service. The output document contains a single field, numRowsInserted, that returns the number of rows inserted.
	If an error occurs while executing the Insert operation, the adapter throws an exception into the Flow. This exception should be caught with a Try/Catch block.
	�
	On the Settings tab, the system defines the template file associated with the selected service, assigns run time parameters, and assigns a universal name. This is currently not used by the EnterpriseOne adapter.
	�
	Enable Service Auditing
	The Enable Service Auditing section defines how you want to audit. Values include: Never, For top-level service only, Always.
	When to log
	This section defines when to log. Values include: Errors only, Error and Success, Error, Success and Start.
	When to include input pipeline
	This section defines when to include the pipeline in the log. Values include: Never, On errors only, Always.
	�
	List ACL
	Users in the allowed list can see that the elements exist and view the metadata (input, output, and so on) for the elements.
	Read ACL
	Users in the allowed list can view the source code and metadata for the element.
	Write ACL
	Users in the allowed list can lock, edit, rename, and delete the element.
	Execute ACL
	Users in the allowed list can run the service.
	Enforce Execute ACL
	This field’s values include: For top-level Servic
	ACL Information
	Click to view the users and groups that compose the ACLs on the Integration Server to which you are connected. This information is read only. To edit ACLs, users, and groups, use the Integration Server Administrator.
	�
	When testing and debugging in the XPI Integration Developer tool, the results of the service appear in this tab.
	�
	
	
	Update Template



	The Update Template enables a user to execute an Update database operation against select tables or business views in the EnterpriseOne database. Update operations are limited to specified interface tables (Z tables) and F47 tables. The system performs
	To create an Adapter Service
	From the File menu, select New, and then Adapter Service.
	Click Next.
	�
	Select EnterpriseOne Adapter, and then click Next.
	�
	On New Adapter Service, select EnterpriseOne, and then click Next.
	�
	Select the Update template, and then click Next.
	Name your Adapter Service following the naming standards in the EnterpriseOne XPI 8.94 PeopleBook: Integration Development Methodology.
	Place the Adapter Service in an Adapter Services package, and then click Finish.
	Select the newly created Adapter Service.
	The following information appears in the right pane under the Update tab:
	EnterpriseOne Connection
	Description
	Type
	Determines whether the update operation will run against a table or a business view.
	Name
	The name of the table or business view.
	Description
	A non-editable field that contains the description of the selected table or business view.
	Note: The table or business view column information appears below the Description field.
	�
	Click the drop-down menu in each of the following fields and select the appropriate values for each:
	Type
	Name
	Under the Column information area, select one value at a time or select all.
	For any row that has a field type other than String, you can select the Field Type box and select the default data type (such as Double, Date, and so on) and change it to a String. This changes the data type of the output field for this row.
	Your finished adapter service should look like the following example:
	�
	Save the Adapter Service.
	Click the WHERE tab.
	�
	This tab enables you to create a Where clause that filters the data in a query.
	Select the Insert Row to add a Where clause line.
	Select AND/OR to determine how this line is applied to the line above it. The AND/OR value for the first line does not matter.
	Under the Left Grouping column, select the grouping level for the line. By placing multiple Where clause lines at the same grouping level, you can build up complex Where clauses.
	Select the column to apply the Where clause filter to.
	Select the operator.
	Select the input field for the filter value. You can rename this field.
	Note
	Do not set this name to the column name. The colu
	Repeat these steps for as many Where clause lines that are needed.
	Save the Adapter Service.
	Review the information that appears on the following tabs:
	Adapter Name
	The name of the adapter.
	Adapter Connection Name
	The name of the connection specified when the adapter service was created.
	Adapter Service Template
	The name for the adapter template used to create the adapter service.
	�
	Input
	The input interface document for the adapter service. This document contains the set of columns selected for the update operation and the set of parameters required for the Where clause.
	Part of the input is a control structure that contains two parameters, acceptNullValues and dateFormat. The acceptNullValues parameter tells the adapter how to handle null input parameters. If this value is set to TRUE, null values are accepted and null
	The dateFormat parameter tells the adapter how to format String values into dates. The default format for dates is: MM/dd/yyyy. Where MM = months, dd = days, yyyy = years.
	Note
	The case of this format is important. MM/dd/yyyy does not equal mm/dd/yyy and does not equal MM/DD/YYYY.
	Output
	The output interface document for the adapter service. This contains a single field, numRowsUpdated. The value in this field is the number of rows updated with the operation.
	If an error occurs while executing the Select query, the adapter throws an exception into the flow. This exception should be caught with a Try/Catch block.
	�
	On the Settings tab, the system defines the template file associated with the selected service, assigns run-time parameters, and assigns a universal name. This is currently not used by the EnterpriseOne adapter.
	�
	Enable Service Auditing
	The Enable Service Auditing section defines how you want to audit. Values include: Never, For top-level service only, Always.
	When to log
	This section defines when to log. Values include: Errors only, Error and Success, Error, Success and Start.
	When to include input pipeline
	This section defines when to include the pipeline in the log. Values include: Never, On errors only, Always.
	�
	List ACL
	Users in the allowed list can see that the elements exist and view the metadata (input, output, and so on) for the elements.
	Read ACL
	Users in the allowed list can view the source code and metadata for the element.
	Write ACL
	Users in the allowed list can lock, edit, rename, and delete the element.
	Execute ACL
	Users in the allowed list can run the service.
	Enforce Execute ACL
	The values for this field include: For top-level service only, Always.
	ACL Information
	Click to view the users and groups that compose the ACLs on the Integration Server to which you are connected. This information is read only. To edit ACLs, users, and groups, use the Integration Server Administrator.
	�
	When testing and debugging in the XPI Integration Developer tool, the results of the service appear in the Results tab.
	�
	
	
	Delete Template



	The Delete Template enables you to execute a delete database operation against select tables or business views in the EnterpriseOne database. Delete operations are limited to specified interface tables (Z tables) and F47 tables. The system performs all
	To create an Adapter Service
	From the File menu, select New, and then Adapter Service.
	Click Next.
	�
	Select EnterpriseOne Adapter, and then click Next.
	�
	On New Adapter Service, select EnterpriseOne, and then click Next.
	�
	Select the Delete template, and then click Next.
	Name your Adapter Service following the naming standards in the EnterpriseOne XPI 8.94 PeopleBook: Integration Development Methodology.
	Place the Adapter Service in an Adapter Services package, and then click Finish.
	Select the newly created Adapter Service.
	The following information appears in the right pane under the Delete tab:
	EnterpriseOne Connection
	Descriptions
	Type
	Whether the delete operation will run against a table or a business view.
	Name
	The name of the table or business view.
	Description
	A non-editable field that contains the description of the selected table or business view.
	Note: Below the Description field you will find information to create a Where clause to control which database rows are deleted.
	�
	Click the drop-down menu in each of the following fields and select the appropriate values for each:
	Type
	Name
	Under the Where information area, select the Insert Row to add a Where clause line.
	Select AND/OR to determine how this line is applied to the line above it. The AND/OR value for the first line does not matter.
	Under the Left Grouping column, select the grouping level for the line. By placing multiple Where clause lines at the same grouping level, you can build up complex Where clauses.
	Select the column to apply the Where clause filter to.
	Select the operator.
	Select the input field for the filter value. You can rename this field to whatever is needed.
	Repeat these steps for as many Where clause lines are needed.
	Save the Adapter Service.
	Your finished adapter service should look like the following example:
	�
	Review the information that appears on the following tabs:
	Adapter Name
	The name of the adapter.
	Adapter Connection Name
	The name of the connection specified when the adapter service was created.
	Adapter Service Template
	The name for the adapter template used to create the adapter service.
	�
	Input
	The input interface document for the adapter service. This document contains the set of parameters required for the Where clause.
	Part of the input is a control structure that contains one parameter, dateFormat. The dateFormat parameter tells the adapter how to format String values into dates. The default format for dates is: MM/dd/yyyy. Where MM = months, dd = days, yyyy = years.
	Note
	The case of this format is important. MM/dd/yyyy does not equal mm/dd/yyy and does not equal MM/DD/YYYY.
	Output
	The output interface document for the adapter service. This contains a single field, numRowsDeleted. This field contains the number of rows deleted from the operation.
	If an error occurs while executing the delete operation, the adapter throws an exception into the flow. This exception should be caught with a Try/Catch block.
	�
	On the Settings tab, the system defines the template file associated with the selected service, assigns run-time parameters, and assigns a universal name. This is currently not used by the EnterpriseOne adapter.
	�
	Enable Service Auditing
	The Enable Service Auditing section defines how you want to audit. Values include: Never, For top-level service only, Always.
	When to log
	This section defines when to log. Values include: Errors only, Error and Success, Error, Success and Start.
	When to include input pipeline
	This section defines when to include the pipeline in the log. Values include: Never, On errors only, Always.
	�
	List ACL
	Users in the allowed list can see that the elements exist and view the metadata (input, output, and so on) for the elements.
	Read ACL
	Users in the allowed list can view the source code and metadata for the element.
	Write ACL
	Users in the allowed list can lock, edit, rename, and delete the element.
	Execute ACL
	Users in the allowed list can run the service.
	Enforce Execute ACL
	This values for this field include: For top-level service only, Always.
	ACL Information
	Click to view the users and groups that compose the ACLs on the Integration Server to which you are connected. This information is read only; to edit ACLs, users, and groups, use the Integration Server Administrator.
	�
	When testing and debugging in the XPI Integration Developer tool, the results of the service appear in the Results tab.
	�
	
	
	XML List Query Template



	The XML List Query Template has built-in hooks for calling EnterpriseOne list operations. You can use one template for several operations; therefore, the adapter can have many adapter services. Each adapter service is a one-to-one mapping to a table, vie
	To create an Adapter Service
	From the File menu, select New, and then Adapter Service.
	Click Next.
	�
	Select EnterpriseOne Adapter, and then click Next.
	�
	On New Adapter Service, select ERP8, and then click Next.
	Note
	The XML List template is available for ERP8 connections only.
	�
	Select a XML List Query template, and then click Next.
	Name your Adapter Service following the naming standards in the EnterpriseOne XPI 8.94 PeopleBook: Integration Development Methodology.
	Place the Adapter Service in an Adapter Services package, and then click Finish.
	Select the Adapter Service.
	The following information appears in the left pane:
	Item
	Description
	ERP8 Connection
	List Data Source Type
	The type of the EnterpriseOne list data source. This could be a table, view, table conversion, or foreign table.
	TC Version
	The version of the table conversion data source selected.
	List Data Source Name
	The name of the table, view, or table conversion.
	Note: The Data Sequencing tab provides the capability to prepare the data sequence. In addition, it provides the capability to do data selection on the selected list data source. The Retrieve Record tab enables you to select the columns for the template
	�
	Click the List Data Source Type drop-down menu and select the appropriate values.
	Type in the source name in the List Data Source Name field.
	Under the Data Sequencing, select one value at a time or select all.
	Under Data Selection, select one value at a time or select all. Select the required clause, column, and operator to prepare the data selection statement.
	Note
	The first row clause should always be WHERE.
	Your finished adapter service should look like the following example:
	�
	�
	You can hard code the data selection value using the Operand column, as shown below.
	�
	Note
	The values should be separated by a comma \(,\�
	�
	Save the Adapter Service.
	Review the information that appears on the following tabs:
	�
	Adapter Name
	The name of the adapter.
	Adapter Connection Name
	The name of the connection specified when the adapter service was created.
	Adapter Service Template
	The name for the adapter template used to create the adapter service.
	�
	Input
	The input interface document for the adapter service. This is the list of input parameters in the control section and columns selected list data source in the data selection statements.
	Output
	The output interface document for the adapter service. This is the list of standard output parameters and parameters selected from the data source columns.
	The template runs in six different modes depending upon the input values. Refer to the following table to determine the input parameters for the desired operation:
	Operations
	Input Parameters
	Output Parameters
	Create List
	listHandle
	Null or empty string
	ListHandle
	The handle returned by the create list operation
	listSize
	Null or empty string
	lastProcessedIndex
	Null or empty string
	ListSize
	The size of the list created by create list operation
	startIndex
	Null or empty string
	endIndex
	Null or empty string
	LastProcessedIndex
	Null or empty string
	deleteList
	False
	Retrieve list
	listHandle
	Valid list handle
	ListHandle
	The listHandle passed in as input parameter
	listSize
	Valid list size
	lastProcessedIndex
	Null, empty String, or a valid index. When this field is set, the Retrieve list retrieves the records next to this index and up to the endIndex
	ListSize
	The listSize passed in as input parameter
	startIndex
	When the lastProcessedIndex is not set to a valid index, this field should be set to a valid index (1 to listSize).
	endIndex
	If null or empty string is the value for this field, then the list from either the lastProcessedIndex or startIndex up to the last index is retrieved.
	LastProcessedIndex
	Index of the last record processed by the retrieve list operation.
	deleteList
	False
	Delete list
	listHandle
	Valid list handle
	ListHandle
	Null or empty String
	listSize
	Null, empty string, or valid list size
	lastProcessedIndex
	Null, empty String
	ListSize
	Null or Empty String
	startIndex
	Null  empty String
	endIndex
	Null, empty String
	LastProcessedIndex
	Null or Empty String
	deleteList
	True
	Create and Retrieve list
	listHandle
	Null or empty string
	ListHandle
	The handle returned by the create list operation
	listSize
	Null or empty string
	lastProcessedIndex
	Null or empty string
	ListSize
	The size of the list created by the create list operation
	startIndex
	1
	endIndex
	Any value more than 1. If a null or empty String is passed, the endIndex is assumed to be the last Index. If the endIndex is greater than the listsize, then the endIndex is set to listSize
	LastProcessedIndex
	The last element index retrieved based on the endIndex
	deleteList
	False
	Retrieve and Delete list
	listHandle
	Valid list handle
	ListHandle
	Null or empty string
	listSize
	Valid list size
	lastProcessedIndex
	Null, empty String or a valid index. When this field is set, the Retrieve list retrieves the records next to this index and up to the endIndex.
	ListSize
	Null or empty string
	startIndex
	When the lastProcessedIndex is not set to a valid index, this field should be set to a valid index (1 to listSize).
	endIndex
	If null or empty string is the value for this field, then the list from either the lastProcessedIndex or startIndex up to the last index is retrieved.
	LastProcessedIndex
	-1
	deleteList
	True
	Create, Retrieve and Delete list
	listHandle
	Null or empty string
	ListHandle
	Null or Empty String
	listSize
	Null or empty string
	lastProcessedIndex
	Null or empty string
	ListSize
	Null or Empty String
	startIndex
	1
	endIndex
	Any value more than 1. If a null or empty String is passed, the endIndex is assumed to be the last Index. If the endIndex is greater than the listsize, then the endIndex is set to listSize
	LastProcessedIndex
	-1
	deleteList
	True
	On the Settings tab, the system defines the template file associated with the selected service, assigns run-time parameters, and assigns a universal name. This is currently not used by the EnterpriseOne adapter.
	�
	�
	Enable Service Auditing
	The Enable Service Auditing section defines how you want to audit. Values include: Never, For top-level service only, Always.
	When to log
	This section defines when to log. Values include: Errors only, Error and Success, Error, Success and Start.
	When to include input pipeline
	This section defines when to include the pipeline in the log. Values include: Never, On errors only, Always.
	�
	List ACL
	Users in the allowed list can see that the elements exist and view the elements metadata (input, output, and so on).
	Read ACL
	Users in the allowed list can view the source code and metadata for the element.
	Write ACL
	Users in the allowed list can lock, edit, rename, and delete the element.
	Execute ACL
	Users in the allowed list can run the service.
	Enforce Execute ACL
	The values for this field include: For top-level service only, Always.
	ACL Information
	Click to view the users and groups that compose the ACLs on the Integration Server to which you are connected. This information is read only; to edit ACLs, users, and groups, use the Integration Server Administrator.
	When testing and debugging in the XPI Integration Developer tool, the results of the service appear in this tab.
	�
	
	Notification Services


	A Notification Service is created from an operation template to trigger a notification flow for a real-time event from EnterpriseOne. This is how the adapter transfers data and communicates with the EnterpriseOne resource.
	
	
	Notification Template



	The Outbound Template exposes the real-time events, Z events, and workflow events from EnterpriseOne. It has built-in hooks for receiving events from EnterpriseOne. You can use one template for several operations; therefore, the adapter may have many not
	To create a notification service
	Create a listener for the notification.
	Note
	For more information, see the PeopleSoft EnterpriseOne XPI 8.94 Installation and Configuration for EnterpriseOne Adapter.
	From the File menu, select New, and then Adapter Notification.
	Click Next.
	�
	On New Adapter Notification, select EnterpriseOne Adapter as the adapter type.
	�
	Select the ERP Event Notification template, and then click Next.
	�
	Select the Listeners:NotificationEnterpriseOne line, and then click Next.
	Name your Adapter Notification Service following the naming standards in the EnterpriseOne XPI 8.94 PeopleBook: Integration Development Methodology.
	Place the Adapter Notification Service in an Adapter Services package, and then click Next.
	Click Finish to create the Notification Adapter service and document.
	The system creates an Adapter Notification Service and an associated document.
	Select the Notification Service. The following information appears in the left pane:
	ERP Event Name
	This is the name of the EnterpriseOne outbound event.
	Select the event. The system loads the event fields in the bottom pane.
	�
	For the Workflow events, the system loads and displays a single event field in the bottom pane, as shown below.
	�
	Save the Notification Service.
	Review the information that appears on the following tabs:
	�
	Adapter Name
	The adapter that owns the Notification Service.
	Adapter Listener Name
	The event listener for the Notification Service.
	Adapter Notification Template
	The adapter template used for the Notification Adapter Service.
	�
	List ACL
	Users in the allowed list can see that the elements exist and view the metadata (input, output, and so on) for the elements.
	Read ACL
	Users in the allowed list can view the source code and metadata for the element.
	Write ACL
	Users in the allowed list can lock, edit, rename, and delete the element.
	Execute ACL
	Users in the allowed list can execute the service.
	Enforce Execute ACL
	The value in for this field include: For top-level service only, Always.
	ACL Information
	Click to view the users and groups that compose the ACLs on the Integration Server to which you are connected. This information is read only. To edit ACLs, users, and groups, use the Integration Server Administrator.
	Enable the Notification service.
	Using the Admin tool (Adapter > EnterpriseOne Adapter >Listeners), check whether the Listener is enabled. If enabled, click the Yes link to disable the Listener.
	�
	Click Listener Notifications on the left side of the screen.
	�
	Enable the Notification by clicking the No link
	�
	Click Listeners on the left side of the screen.
	Enable the Listener by clicking the No link.
	Now the adapter is ready to receive, process, and publish the real-time event required by the notification service.
	Check in the notification service to the Source Control System.
	
	
	Disabling the Notification



	Important
	To ensure that the notification is pushed to the listener, you must perform the following procedure when checking in the notification service. If you do not perform this procedure, the imported notification service will not be registered with the listene
	To disable the notification
	�
	Using the Admin tool (Adapter > EnterpriseOne Adapter > Listener Notifications), disable the notification by clicking Yes in the Enabled column.
	�
	Using the Admin tool (Adapter > EnterpriseOne Adapter > Listeners), disable the listener.
	Check in the artifacts to the Source Control System.
	
	Flow Services


	A Flow Service describes the interaction between the integration tasks. It ties the integration logic together. This is where the system creates the actual logic. The flow generates the WSDL for the web service.
	You call the adapter services in the flow to execute the business logic.
	To create a Flow Service
	From the File menu, select New, and then Flow Service.
	Click Next.
	Name your Flow Service following naming standards in the EnterpriseOne XPI 8.94 PeopleBook: Integration Development Methodology.
	Place the Flow Service in the flow service package.
	�
	Select one of the starter flows, and then click Finish. The default is empty.
	Select the flow. Add in the steps to process the Notification document.
	�
	Go to the input/output tab and select the input and output documents for the flow. If you are creating a flow that processes a notification, then select the publish document that was created for the Notification Service.
	For this example, there is a step to call a service to Save the Pipeline to a File. The input to the flow service is the publish document for a Notification Service.
	�
	In the Pipeline tab, scroll to the SavePipelineToFile service. The input to this service is a file name and location:
	�
	
	Trigger


	A trigger provides the link between the Notification Service and flow to execute when the real-time event is received from EnterpriseOne.
	To create a trigger
	From the File menu, select New, and then Trigger.
	Click Next.
	Name your trigger following naming standards in the EnterpriseOne XPI 8.94 PeopleBook: Integration Development Methodology.
	Place the Trigger in the flow service package in a Triggers folder, and then click Finish.
	The following information appears in the left pane:
	Item
	Description
	Name
	The name of the condition for the trigger. For example,  invoke.
	Service
	The name of the flow service that executes when a real-time event is triggered.
	Document Types
	The publish document that was created when you created the Notification Service.
	Join Type
	This field displays N/A until you specify more than one publishable document type.
	�
	Type the condition name, for example invoke_notifySalesOrder.
	Select the flow service to run when a real-time event is triggered.
	For the document type, select the Publish document that was created when you created your Notification Service. This publish document must match the name of the event; that is, if the event name is notifySalesOrder in the AdapterServices folder, then the
	Note
	The document type should be the same as the document type input for your flow service.
	�
	Save your trigger.
	The samples in this section show examples of adapter services that were built using the PeopleSoft EnterpriseOne adapter templates. The samples illustrate how the adapter services can be used in a flow.
	EnterpriseOne adapter service to call an EnterpriseOne business function
	EnterpriseOne adapter service to call an EnterpriseOne Select database operation
	Notification adapter service from EnterpriseOne that is triggered by an EnterpriseOne real-time event
	Transactions are a flow that show how to start, commit, and rollback a transaction
	EnterpriseOne adapter service to execute a XML List operations
	The tests require that you install and activate the PSFT_EnterpriseOne_AdapterSamples package, and that dependent packages have been installed and activated. If you have not installed and activated the packages, refer to the list in the Introduction sect
	Ensure that you are viewing and running the correct artifact for your connection. PeopleSoft provides sample artifacts for both EnterpriseOne and ERP8 connections.
	For ERP8 business function calls, you must first generate the Java wrappers and note the location of the jar files in your ERP8 connection configuration. For more information, see the PeopleSoft EnterpriseOne XPI 8.94 Installation and Configuration for E
	For EntepriseOne and ERP8 notifications, the PSFT_EnterpriseOne_AdapterSamples package contains default listeners. Before running the notification samples, you must configure the listeners to work with your environment, as well as enable the listener and
	
	Sample #1 – Adapter Service to call an Enterprise


	The PSFT_EnterpriseOne_AdapterSamples package includes Adapter Services for business function calls to AddressBook MBF. The package includes adapter services for both an EnterpriseOne connection and an ERP8 connection. You must ensure that you are viewin
	
	
	Address Book Add



	To review the flow
	Select the addAddressBook flow service under the Business Function folder, and then click the Input/Output tab.
	�
	The input is a reference to the ProcessAddressBook document. The output is a reference to the ConfirmAddressBook document. The documents are located in the docs directory under BusinessFunction.
	�
	Click the Flow tab. The first step in the flow is a DeclareGlobals step that defines constant values that are mapped in the pipeline later in the flow.
	�
	The second step is a call to the AddressBookMBF adapter service. Click the Pipeline tab to view the mappings.
	�
	The next step is a Loop over the phone number array. Select the Loop, and then view the properties in the Properties tab.
	�
	The next step within the loop is a call to the AddChangeElectronicAddressPhone adapter service. This adapter service maintains phone and email records in EnterpriseOne. Click the Pipeline tab to view the mappings.
	�
	The next step is a loop over the Electronic Address array. Select the loop, and then view the properties in the Properties tab.
	
	
	Running the Flow



	To run the flow
	�
	From the Test menu, select Run.
	A screen with the input parameters to the flow service appears.
	Select Load and pull in the test script ABPhoneEmail. You can find the test scripts in the PSFT_EnterpriseOne_AdapterSamples package. To get to this package in the file system, go to the following directory:
	x:\<xpi_install_dir>\IntegrationServer\packages\PSFT_EnterpriseOne_AdapterSamples\pub\doc\testscripts
	where x is the drive where XPI was installed
	�
	Select the ABPhoneEmail test script, and then click Open.
	The system loads the input parameters.
	Click OK.
	�
	The flow service runs, placing the confirm document in the Results tab with the newly assigned address book number.
	
	Sample #2 – Adapter Service to call an Enterprise


	The PSFT_EnterpriseOne_AdapterSamples package includes Adapter Services for executing a database select query against the F0101 EnterpriseOne table. Before you run this sample, you must ensure that the EnterpriseOne connection is enabled.
	
	
	Select Database Query.



	To review the adapter service
	Select the AddressBookQuery service under the AdapterServices folder, and then click the Select tab.
	�
	This service is configured to perform a query against the F0101 Table and retrieve nine fields (AN8, ALPH, DC, USER, PID, UPMJ, JOBN, UPMT, USER). At the bottom of the tab, notice that the Max Rows is set to 10 to limit the number of results.
	Select the WHERE tab to examine the where clause for this query service.
	�
	There are three where clause rows for this query. In SQL, this query would generate the following:
	(ALPH LIKE 'PeopleSoft' OR (AN8 > '1000' AND AN8 < '2000))'
	Remember, the very first AND/OR value does not ma
	
	
	Running the Adapter Service



	Adapter Services can be run just like any service on the system.
	To run the Select query
	�
	From the Test menu, select Run.
	A screen with the input parameters to the flow service appears.
	�
	For each parameter, enter the following values:
	INPUT_AN8_Lower – 1000
	INPUT_ALPH – PeopleSoft
	INPUT_AN8_Higher – 2000
	Note
	Optionally, you can enter your own values and run the query. With the Max Rows set to 10, you will never retrieve a large result set.
	Click OK to execute the query.
	Click OK.
	After the query is complete, the view changes to the Results tab.
	�
	Click the resultSet document array. The system displays all of the documents in the grid at the bottom of the screen.
	
	Sample #3 – Notification Service for Outbound Eve


	The PSFT_EnterpriseOne_AdapterSamples package contains a Notification Service for the RTSOOUT real-time event in EnterpriseOne. This package also contains the listener and associated trigger. These notification services were created with both an Enterpri
	
	
	Sales Order Notification



	To review the flow
	�
	Open the Adapter Services folder, and then select the notifySalesOrder notification service. This is a notification service for the RTSOOUT real-time event in EnterpriseOne.
	�
	Open the notifySalesOrderPublishDocument. This is the interface document that was created for the notification service by the EnterpriseOne adapter.
	�
	Open the Notifications folder, the triggers folder, and then select the trigger. This trigger causes the flow service to run.
	�
	Select the notifySalesOrder flow service under the Notifications folder. When run, this trigger initiates the flow service. Subsequently, the flow copies the real-time event XML in the pipeline to a file, in which you can view the XML.
	
	
	Running the Flow



	To run the flow
	To trigger the notification, you must sign in to the EnterpriseOne or ERP8 environment and enter a Sales Order. Entering the Sales Order produces a real-time event. The trigger processes this real-time event and runs the flow service, which writes the ev
	The system writes the file to the C drive and names it SalesOrder.log. For ERP8, the file is named SalesOrder_ERP8.log.
	If you would like the file to be written to a different location, you must change the location on the savePipelineToFile service. Go to the pipeline for the service call and scroll to the input to the service.
	�
	Right-click the filename and select ModifyValue.
	�
	On Input for ‘fileName,’ type the location and na
	Select the following option:
	Overwrite pipeline value
	Click OK, and then save the flow service.
	Find and open the file to view the XML.
	
	Sample #4 – Transactions
	Multiple Address Book adds



	This sample is a flow that calls the AddressBookMBF adapter service multiple times. The last execution of the adapter service does not map the alpha name. This is a required parameter for the AddressBookMBF and will cause the business function to fail. T
	To review the flow
	Open the Transaction folder in the PSFT_EnterpriseOne_AdapterSamples package. Select the multipleAddressAdd flow.
	�
	The first step in the flow is a GenerateKey service. When you start a transaction, you must give the new transaction a unique name to distinguish it from other transactions in the system. Since a single flow may be called by multiple threads at the same
	To assist in generating a unique name, inside the PSFT_E1_Adapter package is the following service:
	PSFT_E1_Adapter.enterpriseone.services:GenerateKey
	Whenever this service is called, it returns a unique value that should be used as the input for a transaction.
	The next step in the flow is startTransaction. Click the startTransaction, and then click the Pipeline tab. Scroll to the startTransaction input and output parameters. The unique key generated by the GenerateKey service is mapped into the startTransactio
	�
	The third and fourth steps in the flow are a call to the AddressBookMBF adapter service. They have been mapped to send the necessary information and will complete successfully. The fifth step is a sequence step to provide a Try/Catch block. The call to t
	Select the commitTransaction and the Pipeline tab.
	Scroll to the commitTransaction input and output parameters. When calling the commitTransaction service, you must specify the same name that you used in the startTransaction.
	Select the rollbackTransaction and the Pipeline tab.
	Scroll to the rollbackTransaction input and output parameters. When calling the rollbackTransaction service, you must specify the same name that you used in the startTransaction.
	Running the Flow
	To run the flow
	�
	From the Test menu, select Run.
	A screen with the input parameters to the flow service appears.
	Click Load and pull in the test script TesttranAB. You can find the test scripts in the PSFT_EnterpriseOne_AdapterSamples package. You can use the same test script for both EnterpriseOne and ERP8 environments.
	To get to this package in the file system, go to
	x:\PeopleSoft\xpi\IntegrationServer\packages\PSFT_EnterpriseOne_AdapterSamples\pub\doc\testscripts
	where x is the drive where XPI is installed.
	�
	Select the TesttranAB test script and click Open.
	The system loads the input parameters.
	Click OK. The flow service runs and displays the following exception:
	�
	To check that the first two address book records were rolled back, you can look at the log. To find the log in the file system, go to the following directory:
	For EnterpriseOne:
	x:\PeopleSoft\xpi\IntegrationServer\logs\EnterpriseOneAdapter\jasdebug_date.log
	where x is the drive where XPI is installed
	For ERP8:
	x:\PeopleSoft\xpi\IntegrationServer\logs\ERP8Adapter\jasdebug_date.log
	The log file contains the following information:
	14 Nov 2003 11:01:22,181 [HTTP Handler 127.0.0.1] DEBUG: {com.jdedwards.system.kernel} - CallObject@17f9037: complete in 691ms BSFN:AddressBookMasterMBF user:KL5449350 Env:PY9NIS2 ManTran:true RTC-hasCache:false CO-hasCache:false��14 Nov 2003 11:01:22,18
	2003-11-14 10:54:14.406 [HTTP Handler 127.0.0.1] KERNEL  : CallObject@1719660: complete in 431ms BSFN:AddressBookMasterMBF user:MS7116364 Env:DV7334NIS2 ManTran:true RTC-hasCache:false CO-hasCache:false��2003-11-14 10:54:14.786 [HTTP Handler 127.0.0.1] K
	
	Sample #5 – Adapter Service for XML List Operatio


	The PSFT_EnterpriseOne_AdapterSamples package contains a Adapter Service that uses Create, Retrieve, and Delete XML List operations. This adapter service was created for an ERP8 connection only. You must ensure that you are viewing and running the correc
	
	
	AddressBook



	To review the flow
	�
	Open the Adapter Services folder, and then select the AddressBookList service. This is a service for the address book query using list API.
	�
	Click the Input/Output tab and notice the input parameters for the list template. The value that gets passed to the template through these parameters determines the operations the template will perform. The sample demonstrates how the template performs a
	View the mapping in the lower plane.
	�
	
	
	Running the Flow



	To run the flow
	Select AddressBookQuery under XMLListQuery, and then click the RUN button.
	�
	Enter the above shown values, and then click OK.
	�
	View the results in the Results tab.
	Resolving Adapter Problems
	This section discusses the following topics:
	Logging
	Errors
	Several log files provide assistance with resolving problems if the adapter is not functioning correctly:
	You can find the logs in the following location:
	x:\xpi install dir\IntegrationServer\logs
	where x is the drive where XPI is installed
	
	EnterpriseOne Adapter Logs


	When using an EnterpriseOne connection, the EnterpriseOne Adapter directory creates the following five logs:
	jasdebug_date.log
	Use this log for information about the dynamic connector and the execution of the business functions. This is also where you can find information about connections, and rollback and commit of transactions.
	jas_date.log
	Use this log for information about the dynamic connector connection to EnterpriseOne.
	rt.log
	Use this log for information about the EnterpriseOne real-time events.
	rtdebug.log
	Use this log for debug information about the EnterpriseOne real-time events.
	jderoot_date.log
	Use this log for basic information about the EnterpriseOne connection.
	
	ERP8 Adapter Logs


	When using an ERP8 connection, the ERP8 Adapter directory contains the following four logs:
	jasdebug.log
	Use this log for information about the java connector and the execution of the business functions. This is also where you can find information about connections, and rollback and commit of transactions.
	jas.log
	Use this log for information about the Java connector connection to ERP8.
	rt.log
	Use this log for information about ERP8 real-time events.
	rtdebug.log
	Use this log for debug information about ERP8 real-time events.
	This section contains some of the common errors that can occur when programming the adapter, along with instructions on how to remedy each error.
	
	Error Configuring a Listener


	You might receive the following error when you configure a listener. However, the error does not prohibit the configuration from occurring. The error is related to the version of Internet Explorer on which the Integration Server is run. Click No and the
	�
	
	Error When Creating a Notification Service


	You might receive the following error when you create a notification service in Integration Developer. This occurs when the connection is lost to EnterpriseOne or ERP8. If you receive this error, you must delete the partial notification service from your
	�
	
	Adapter is Not Picking Up Real-Time Events


	The Adapter will not pick up real-time events if the notification is not pushed to the listener.
	To make sure the notification is pushed to the listener
	�
	In the Developer tool, identify the listener that is attached to the notification service.
	�
	In the Admin tool, under Adapter > EnterpriseOne Adapter > Listeners, click the View button next to the listener.
	�
	Click the View Notification Order link.
	�
	Verify that the notification is listed in the Notification Order list box
	Note
	See step 17, “Check in the notification service t
	
	Adapter Runtime (Notification): Error Publishing Notification


	If you see the following error in the server log, the broker document is not synchronized with the Integration Server document:
	[ART.116.3010] Adapter Runtime (Notification): Error publishing notification AdapterServices.Notification.Supplier:notifySupplierEvent. Error: [ISS.0098.9014] BrokerException: Unknown Document Type (226-1490): Document type 'wm::is::AdapterServices::
	Use the Developer tool to synchronize this document with the broker.
	To synchronize the document with the Broker
	Open XPI Developer and connect to the same Integration Server environments to which you installed the Integration Points.
	�
	From the File menu, select Sync Document Types, and then All Out-of-Sync.
	�
	For each document type that is listed, verify that the value in the Action column is Push to Broker.
	Click the Synchronize button.
	
	Error Retrieving Large Records Using List Template


	If the Integration Server runs out of memory while retrieving a large number of records, the following message appears in the Developer tool:
	�
	In addition, the server log does not indicate the response for the retrieve list operation, as shown in the following example:
	2004-03-22 14:45:51 MST [ADA.7180.7070D] Response received from ERP server for create list request:-"XML Request OK"
	2004-03-22 14:45:51 MST [ADA.7180.7066D] Create List execution complete. List handle:-"lrj405f5f06007c-00000a34-00000003-00000000000000000000ffff0ae6fc" List Size:- "6272"��2004-03-22 14:45:51 MST [ADA.7180.7064D] Executing GetGroup (Retrieve)  List Op
	The Integration Server error log indicates only null, as shown in the following example:
	com.wm.pkg.art.error.DetailedServiceException: [ART.117.4002] Adapter Runtime (Adapter Service): Unable to invoke adapter service services:ListQuery.��null��at com.wm.pkg.art.error.DetailedServiceException.create(DetailedServiceException.java:125)
	To solve this problem, you can increase the amount of memory on the Integration Server, and set up the system to retrieve records in chunks.
	To increase amount of memory on the Integration Server
	Stop the Integration Server.
	Go to the following location: <Integration server install dir>\bin.
	Open the server.bat file for edit.
	In the SETLOCAL section, change the JAVA_MAX_MEM setting to a higher value depending on the requirement of your system. For example, change the following setting:
	From:
	set JAVA_MAX_MEM=256M
	To:
	set JAVA_MAX_MEM=512M
	Save the file
	Restart the Integration Server.
	To retrieve records in chunks
	You can set the system to retrieve records in chunks by providing the correct input values to Start Index, Last processed Index, and/or End Index.
	
	Errors Changing the Data Selection Parameters in List Template


	You might encounter the following List Template errors.
	Sequence Name does not match.
	�
	Data Selection Operand Field does not appear or will not change when the Operator is changed.
	�
	To resolve the List Template errors
	Delete the data selection row using the Remove Row button, and then add it back using the Add Row button.
	Select the correct operator.

